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Servo Drive Setup Guide

TSD and TSP Series

This user guide describes how to set up the TSD and TSP servo drive series.
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Abbreviations

AC Alternating Current

DC Direct Current

HMI Human-Machine Interface

LED Light Emitting Diode

PC Personal Computer

STO Safe Torque Off

TAM Triamec Advanced Motion

TAM API TAM Application Programming Interface
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1 Introduction

This user guide describes how to set up the TSD and TSP servo drive series.

After a short description of the required hardware and software setup in chapter 2, the user guide ex-
plains the usage of the TAM System Explorer software in chapter 3 and 4. Chapter 5 describes the com-
missioning and tuning of a servo axis. Chapter 6 handles several advanced topics.

To control Triamec drives with Beckhoff TwinCAT, first setup the drives as described in this document.
Then proceed to document [2] for a Tria-Link setup, or [3] for an EtherCAT setup.

Names in italics, like Triamec, are general keywords. Register names and paths are indicated according
to the following example: Axes[0].Parameter.PositionController.OutputLimit. Bold expressions indicate a
HMI item, i.e. File > Open. Keyboard keys are formatted like Enter.

This version of the user guide requires the use of a TAM System Explorer version > 7.28.2 and a drive
firmware version > 4.24.0

ServoDrive-SetupGuide_EP030 2025-05-02 3/86
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2 Hardware and Software Setup

This chapter describes the hardware prerequisites and the installation of the required software used for
commissioning of the drive.

2.1 Hardware Prerequisites

For the commissioning of the Triamec drive with this user guide the following hardware setup is re-
quired.

= A motor with an encoder connected to the drive.

The DC-bus is supplied with an appropriate DC voltage using a Triamec power supply.
The drive logic is supplied with 24VDC.

= Make sure the STO channels are connected correctly to fulfill the safety requirements.
= Connect the drive with the PC (see section 2.3 for further information).

See also the corresponding hardware manual for further information:

= www.triamec.com > Support > Documents > Manuals
= or Help > Documentation > Hardware in TAM System Explorer.

2.2 Software Installation

For the commissioning of Triamec drives TAM System Explorer is required. TAM System Explorer pro-
vides access to the drive parameters, commands and signals. Additional tools are available for measur-
ing signals, identifying the dynamic behavior and tuning the controllers. TAM System Explorer is an ap-
plication based on TAM API and is installed as part of the TAM Software package. Administrator rights
are required during the installation process. The following steps describe how to run the installation:

1. Download the current release of TAM Software from www.triamec.com > Support > TAM Soft-

ware.

2. Extract the downloaded ZIP file and run the installer TAM Software *.*.* Setup.exe.

3. The TAM Software Setup dialog is opened (Figure 1). Click Install to start the installation process.

4. If a User Account Control dialog is opened check if the verified publisher is correctly identified as

ServoDrive-SetupGuide_EP030 2025-05-02 4 /86
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Triamec Motion AG and acknowledge the installation process.

5. The setup process will also install the required drivers. Additional prompts might appear during
this process which need to be approved.

6. In some cases a restart of the PC is required to complete the installation process. In this case, a
prompt will pop up with the request to restart the PC.

TAM Software 7.xx.y Setup — X
,)) TAM Software 7.xx.y
triamec
Options % Install Close

Figure 1: TAM Software Setup

2.2.1 Deinstallation
Deinstall the TAM Software by means of the operating system’s controls.

In some side-by-side installation scenarios, uninstalling the TAM Software might fail. In such a case, first
repair the software, then uninstall. Repair is accessible via the uninstall routine, as shown in Figure 2.

TAM Software 7.xx.y Setup — X

,)) TAM Software 7.xx.y

triamec

Modify Setup

Uninstall Close

Figure 2: Deinstall the TAM Software

Note Uninstalling the TAM Software might also remove the associated device drivers. In this case
all programs accessing Triamec devices may fail.

ServoDrive-SetupGuide_EP030 2025-05-02 5/36
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2.3 Connect Drive to PC

For the commissioning of the drive, the following options are available to connect the drive with the
PC:
2.3.1 USB

= Connect the drive to the PC with a USB cable. Multiple drives can be connected together to the PC
by using a USB hub.

= An existing Tria-Link network can be connected with an (external) PC via USB by connecting the PC
to the adapter card as described in chapter Error: Reference source not found.

In case a Windows Explorer window opens when the drive is rebooted or when USB is connected to the
PC, this can be suppressed by changing the following Windows settings:

= Windows Start Button — Settings (gear wheel) — Auto Play
= Under Removable drive select Take no action from the pull-down menu.

2.3.2 Ethernet

Up to 4 drives may be directly connected to a PC over Ethernet. Leave the IP configuration of the drive
on the default values (DHCP). For more connection types with Ethernet see document [4].

2.3.3 Tria-Link

Please refer to document [12] for more information about how to connect a PC to a Tria-Link system.

ServoDrive-SetupGuide_EP030 2025-05-02 6/36
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3 How to use TAM System Explorer

This chapter gives an introduction into the usage of TAM System Explorer.

If TAM Software is installed correctly TAM System Explorer can be executed from the Windows Start
Menu. Figure 3 shows the window after the start, containing the following panels:

1. Topology Tree: The topology tree allows to navigate between different devices and registers.

2. Axis Monitor: The axis monitor shows the state for each axis and allows to acknowledge pending
errors. Additionally, emergency buttons are provided.

3. Scope Area: The scope allows to plot the values of all registers provided by the topology tree.

4. Tab Panel: The tab panels are used to write and read to registers from the Topology Tree, to set
the scope properties and to log messages.

Triamec [USB] - TAM System Explorer

File Scope Help
5 B[Q] « $-@-90 B ?

=i PC-CHM 80 -

5 o TSD350-10-1L Ol . 0B
50 - ! : ! !

=52 Link

=@
: B_j Device

~'§ Register . 5 : : ;
-#) Tama Manager B A B R B i
/0 AN (A) 0 200 400 600 800 1000
® t [ms]
il General § Registers ‘@ Module 1~ Scope ] Log @
Epal
v Identification ~
Axis C.. l. A. State Device serial number TMS00320
@) 4 viomec-320 Avis 0 Na”;e R Triamec-320 _
A Triamec-320 Axis 1 Pro cht |.n ormation Type: TSD350-10-TL Rev: 0 Firmw:i
¥ Monitoring v
- @ Name

The name of the TAM node.

z N Address [tam://localhost/TSD350-10-TL/Link/Triamec-320/

" Acknowledge Errors = F12: Switch off power sections Pause: Stop all axes

Figure 3: TAM System Explorer after start up. 1: Topology Tree; 2: Axis Monitor; 3: Scope Area; 4: Tab Panel
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3.1 Topology Tree

After an initializing phase, the Topology Tree shows the actual hardware content of the system. The
Topology Tree is built out of the following objects:

I;I'ﬂ Local Computer Computer on which the TAM System Explorer is running

Tria-Link Adapter Card PCle adapter card used to communicate over Tria-Link.

==  USB Adapter Device connected via USB. Drives and TL cards are equipped with a USB connector.
=8=  Ethernet Adapter Used to communicate over Ethernet

Offline Adapter Examine a system while not being connected

@ Tria-Link Tria-Link communication channel used to connect the adapter with devices

%%  Tria-Link Observer Tria-Link communication channel in observer mode

@  Station Addressable node within the link

Bl Device Logical unit providing a register tree, for example a servo drive

Bl

& Register Node Collection of registers with similar purpose (array of similar structures)

o

@ Register Representing a parameter, a command, a signal or information

<#®  Register Array An array of registers of the same type

& Tama Manager Allows to assign, download and enable Tama programs

@ Module User interfaces which simplify the register access e.g. for the tuning of the axes.
G Option Module Option module for additional input and output.

Note If a connected device is not listed in the Topology Tree, execute a restart (File > Restart).

It is recommended to give the stations a meaningful name e.g. Station XY, Station Z. The naming of the
station can be changed by selecting the station and then clicking the station name or pressing F2. The
station name is stored in register General.Parameters.DeviceName in the Topology Tree. The hardware
device related to the station can be identified either

= by the serial number which is displayed in register General.Signals.|dentifications.SerialNumber.

= or by activating the status LED (red blinking) of the drive by setting General.Commands.ExternalEr-
ror to TRUE. To reset the status LED set ExternalError to FALSE and press the « Acknowledge Errors
button.

Each device in the Topology Tree provides a Register Tree. The Register Tree is the basic interface be-
tween TAM System Explorer and the device. The registers are divided into three or four classes:

= Parameters

= Commands

= Signals

= Information (Axes only)

ServoDrive-SetupGuide_EP030 2025-05-02 8/86
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In order to interact with a register unfold the Topology Tree until the desired register gets visible.
The registers may be hidden, to reduce vertical amount of space occupied by the tree. In order to show
them, click on the Show/Hide individual registers Button <.

Triamec [USB] - TAM System Explorer

Eile  Scope Help
=) « P-@-9 @ H ?
“' 1) Topology 0 a0-
2~ 18 PC-CHM - . Revert Registers
B * & TSDA0T-HS - : ' L N
&% T Link Commit Registers
=% @ Gugugs | _ Ty g genemmeReRnEEe ‘S
C ok . T T e N SR R
=7 —BJ Device 600 800 1000 1200
- Register t[ms]
- & General
Wé”% = & Registers & Module ] Scope ] Log
B : +w" Parameters
----- % DeviceName
..... ® 9 DcBusVoltagellpperLimit Register Actual Prepare Unit  Description 2
----- < DcBusVoltagelowerLimit DeviceMame Gugugs Gugugs - The name of the drive. Th
""" & EnableAsynchronousTama DcBusVoltagelpperLimit ] 150 v Upper limit for the DC-bu
----- < EnablelsochronousTama — .
DcBusVoltagelowerLimit ] 0|V Lower limit for the DC-bu
----- <» Standalone
_____ & UseDedicatedLink&ddresses EnableAsynchronousTama False False | - Start the Asynchronous T
----- & LinkAddress EnablelsechronousTama False False |- Start the [sochronous Tan
[ LinkGroupAddresses Standalone False False |- Do not enforce Tria-Link ¢
""" & LogSeveritylevel ¥ || UseDedicatedLinkAddresses True True | - Assign dedicated address
€ >
LinkAddress 5 51- Dedicated drive address a v
Axis C. L. A State
. X ReadyToSwitchQ ¢ >
sacye Wf N General parameters for drive
Y ReadyToSwitchOn
Address  [tam://mc/Gugugs/General/Parameters/
Ik
Acknowledge Errors F12: Switch off power sections Pause: Stop all axes

Figure 4: TAM Topology Tree and Registers

A click on a register node or a register opens the Registers tab in the Tab Panel. All registers contained
in the selected register node are listed in the Registers Tab Panel.

3.1.1 Parameters

Parameters are used to configure the drive for the intended application, e.g. to set up the position con-
troller or the encoder. Typically, a parameter value is written when commissioning the drive and re-
mains unchanged, except if the system is changed. Parameters can be stored in a configuration file on
the PC or persisted on the drive (see sections 3.5).

In the Registers tab (see Figure 4) the Parameters are listed with the following columns:

= Register —> the name of the register, corresponding to the name in the tree

= Actual -> the actual register value stored on the drive

= Prepare -> the register value which will be written to the drive after clicking Commit
= Unit - physical unit of the value

= Description - short description of the parameter

ServoDrive-SetupGuide_EP030 2025-05-02 9/86
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Only the prepare field is editable. If the prepare value has a gray background, the register is read only. A
changed value gets an orange background. This state remains until it gets committed.

Parameter handling buttons:

+ Commit Updates the drive with the values of the prepare fields.

> Revert Reverts the prepare fields with the values from the actual fields.

Setting a parameter value:
1. Enter the desired value into the prepare field of the appropriate register

2. Press Enter or click into another register. The background of the edited field gets orange.

3. Click the Commit button to transmit the value to the drive. After a successful commit, the back-
ground of the prepare field turns back to white.

A star (*) in front of a tree item indicates an uncompleted commit.

3.1.2 Commands

Commands are used to change the state of the device, e.g. to set a digital output or to execute a move.
The state of a command can not be stored and will be reset after a restart of the device.

In the Registers tab (see Figure 4) Commands are listed with the following columns:

= Register - the name of the register, corresponding to the name of the tree view
= Value - the actual value of the command
= Unit - physical unit of the value

= Description - short description of the command

Command values can be edited directly, no commit command is required to execute the command:
1. Enter the desired value into the value field of the appropriate register.
2. Press Enter or click into another register to execute the command.

3.1.3 Signals
Signals allow real time observation of the state of the drive.

In the Registers tab (see Figure 4) Signals are listed with the following columns:

= Register - the name of the register, corresponding to the name of the tree view
= Value -> the actual value of the signal
= Unit -> physical unit of the value

= Description -> short description of the signal

All signals are read only.

3.1.4 Information

For each axis registers Axes[].Information can be used to document the properties of the axis. Informa-
tion registers do not affect the behavior of the drive in any way. Information registers are also stored
with the TAM configuration file on the PC or persisted on the drive (see sections 3.5).

ServoDrive-SetupGuide_EP030 2025-05-02 10/s6
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Note The register Axes[].Informaton.AxisName is used by the axis monitor, the scope and the
modules to display the axis identification.

3.2 Axis Monitor

Below the Topology Tree the axes are listed in the Axis Monitor as a flat list.

The axes are identified by the register Axes[].Information.AxisName. Initially the station name is added
in front of AxisName, but will be removed when the axis name is changed the first time.

The axis name can be changed by selecting the axis name in the axis monitor and clicking it again or by
pressing F2. The modified axis name is also stored in the register Axes[].Information.AxisName.

Axis C.| L. A State
. .K Continuoushaotion

Y Disabled
h O @® u p
o B P ReadyToSwitchOn

« Acknowledge Errors

Figure 5: The axis monitor shows the state for each axis and
allows to acknowledge pending errors. Additionally, the
emergency buttons are provided.

The axes are highlighted according to their state:

= Enabled: Enabled axes are marked with a green square.

= Error: If an axis has a problem, the axis is marked with an error icon. The error type is shown in the
State column, highlighted in red. Resolved errors don't simply disappear. They need to be acknowl-
edged using the « Acknowledge Errors button. If no errors are pending for acknowledgment, this
button is grayed out.

= Warning: Orange state color indicates a warning.

Warnings as well as errors which can't yet be acknowledged need some interaction, for example provid-
ing the required DC bus voltage in case of a DcBusVoltageOutOfRange warning.

The Control system overridden column shows a slowly blinking ,: icon on orange background as long
as an axis module is attached (see chapter 4.1).

The Asy VM and Iso VM columns reflect the states of the asynchronous and isochronous Tama virtual
machines (see chapter 3.8). Different characters are shown depending on the state.

ServoDrive-SetupGuide_EP030 2025-05-02 11/86
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Character Meaning

(empty)  There is no Tama program on the device
[ | The virtual machine is not operational
> The virtual machine is operational

- The state is not retrieved and therefore unknown

In case of a communication failure, the state of a device can be shown as Unresponsive, or even as
Link down, if the entire link is broken.

Caution In some cases' the communication between the Axis Monitor and the drive could be sus-
pended. In these cases, the axis state is probably not reflected correctly. Check the registers

General.Signals.DriveState and Axes[].Signals.General.AxisState instead or restart TAM Sys-
tem Explorer (File > Restart).

The axis monitor also provides two emergency buttons:

@ Emergency switch off: All power sections will switch off immediately, if this button is
pressed. The axes are then released and may move until the kinetic or potential energy is
dissipated. Pressing the emergency button will cause an external error which has to be reset
e.g. by pressing the « Acknowledge Errors button.

@ Emergency Stop: If emergency stop is pressed, the path planner will issue a stop move
based on the emergency parameters. This brings all active axes to a halt. The axes will re-
main enabled.

Caution Switching off the power section of a drive during motion may damage the mechanical axis.

1 Communication is suspended after a soft reboot of a drive with persistent link address observed via Tria-Link, or after an initialize of
the Tria-Link executed by another control system.

ServoDrive-SetupGuide_EP030 2025-05-02 12/86
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3.3 Scope

The scope is a very powerful tool with a lot of functionalities. It allows plotting all register items (Sig-
nals, Parameters, Commands) with a sampling rate of up to 100kHz. To add a register item to the scope,
simply drag it from the Topology Tree and drop it into the Scope Area (see also Figure 6).

Remarks Drag and drop of registers is not possible while the scope is running.

Registers from a second drive can only be added (drag and drop) when the two drives are
synchronized (e.g. if they use the same link).

If the Topology Tree doesn’t show the registers, click the Show/Hide individual registers
Button <.

Scope settings can be set by opening the Scope tab in the Tab Panel (see section 3.3.1). Controls related
to the scope can be found either

= in the scope menu in the main menu bar,

® in the scope tool bar

= or by opening the context menu with a right click on the Scope Area.

Triamec [USB] - TAM System Explorer

Eile  Scope Help

[@] «|@e-—-|4 ]| @2 8| °
|—;|...-£_'-.- TSD130E-HS Al g0
5.5 Link -
- @ TriamecTraining

E|_B_+ Device 60 - s demmmnneeeeeeaaes demmmnneeeeeeaaes fommmmeeeeeeaans fommmneeeeeeaaas
-4 Register ; : : : :
L G | E ; ! . .

G-§ Genera B b A O O A A e e

[~ Subscriptions

-4 Parameters - : : : :
---‘Q Commands 3 P S S S O
B4 Signals : : = : :

----- <» DriveState i

----- <» DriveError D R i L L LU

----- <» DcBusVoltage -
----- <» DcBusVoltageHardwarel a2
I

T e B B N B L
----- <& GlobalTime 0 200 400 600 800 1000
----- <» TralinkTimestamp t[ms
----- <» CommandTimestamp
- |dentifications El General @ Registers ‘@ Module k2| Scope 4| Log
- S?.rstemLoad General Plot —- Cursor # S 5 Plots HLFFF Ed - Analysis
- SignalProcessors v -
< > v Behavior - MName
- g DriveState
. Axis Con... | I | A| State Register tam://'mc/TriamecTra . . -
X ReadvToSwit . TriamecTraining DriveError
eady Sampling Time 1 ms v
¥ ReadyToSwit] S ——
. ampling Time
=} ReadyToSwit
@ sacy o W? The sampling time of acquired data. When
© ReadyToSwit changing, this value will be rounded to the ...
= 5 | Address |tam:,a‘g‘mc,a'TriamecTraining,."Generalg‘Signals,a'Dri\reError
Acknowledge Errors F12: Switch off power sections Pause: Stop all axes

Figure 6: Scope actions: Drag and drop the registers you want to visualize into the scope.
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3.3.1 Scope Settings

To modify the scope settings, click the Scope tab in the Tab Panel or click the Scope Area to activate the
Scope tab. Its right area contains the list of registers (called Plots) assigned to the scope. The left area
displays the tabs with the scope settings, which are divided into three groups:

= The General tab specifies scope properties valid for all plots.
= The Plot tab specifies the properties of the currently selected plot.
= The Cursorl or Cursor2 tab owns the properties of the two cursors and the trigger.

To remove a plot from the scope, select the plot entry in the Plots list and press Delete or click the
Delete the selected plot(s) button &=.

Remark Scope settings can not be modified while the scope is running.

3.3.2 Sampling Time

The default sampling time is 0.1 millisecond. The sampling time can be increased or decreased by
changing the Default Sampling Time in the General tab for all signals or by changing the Sampling Time
in the Plot tab for individual signals (Figure 12 and Figure 13). The scope supports the following sam-
pling times: 0.01ms, 0.02ms, 0.1ms and multiples of 0.1ms. Unsupported values will be rounded to the
next valid sampling time.

The maximal number of values which can be received from a drive depends on the sampling time and
the data type of the register. Most registers contain 32-bit values, only absolute positions without a
'Float' identifier are 64-bit values. The following table shows the maximum number of plots depending
on the sampling time and the register type:

Sampling Time [ms] 32-bit values 64-bit values
0.01 8 4
0.02 16 8
20.1 80 40

When the maximal number of plots is exceeded, an error message will pop up (Figure 7). In this case
the number of plots must be reduced or the sampling time increased.

Scoping Error Ii:?-]

f - 1 Acquisition set up failed, Failed tn:L\\;reate a Tria-Link subscription,
‘S Unable to subscribe. The maximum number of subscriptions was
exceeded in the publishing station, or an illegal offset was specified.

Figure 7: Scoping Error

ServoDrive-SetupGuide_EP030 2025-05-02 14/86
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Remarks A large number of plots with small sampling time will cause a huge data stream. Depending
on the performance characteristic of the PC this could severely reduce the responsiveness
of TAM System Explorer, especially if expensive plot styles are used e.g. if Plot > Apearance
> PointStyle is different from None.

Other applications using the same link (e.g TwinCat) can reduce the maximum amount of
registers which can be plotted.

3.3.3 Sampling Duration

The sampling duration can be set by clicking on the minimum/maximum label of the time axis in the
scope (Figure 8). The unit of the time axis is millisecond.

10-  10-  80-

e
0 100 200 300 400 D|
t [ms]

Figure 8: Sampling duration and multiple Y axes.

Remark Long sampling duration and small sampling time with a large number of plots will cause a
huge amount of data. Depending on the characteristic of the PC this could cause memory
issues, especially on 32 bit PCs.

3.3.4 Y Axes

Y axes can be created, edited and removed by opening the YAxis Collection Editor by clicking General >
YAxis > =/ in the Scope tab (see also Figure 12).

= Use Appearance > Caption to name the axis.

To assign a plot to an existing axis, select the plot in the Plots list and assign the axis with the pull-down
menu from Plot > Axes > YAXis.

Y range:

= The min/max range of an axis can also be changed by clicking on the min/max axis label (Figure 9).
= Clicking on the upper part of a Y axis will scale into the range, clicking on the lower part scales out.
= The Y axis has a context menu (click right on the axis) with entries to achieve the same effect.

ServoDrive-SetupGuide_EP030 2025-05-02 15/86



,)) How to use TAM System Explorer
] Scope
triamec

= You can also move plots up and down by dragging their Y axis.
= Use the center button # to vertically center the selected plot.

The scope always activates the Y grid of the Y axis that the mouse hovered over last. The Y grid is also

adjusted when hovering over a plot in the Plots list. This can be disabled by making a Y grid sticky with
the context menu of the axis as shown in Figure 10.

B

B U S N O N
400 e b S
= - : : : :
i - : s s : - ;
T 20— PR Fenemeenenaes Bosnenennas B e SEssmmmmee
: : : ; Scale In
R e . . Scale Qut
-23—:. o e e e e e e Sticky Grid
0 200 400 600 &00 1000 :
£ [ms]
Figure 9: Changing the Y axis range Figure 10: Y axis context menu items

3.3.5 Triggering

To start scoping press the Start button ®. By default the scope is in single trigger mode ®. For auto-

matic triggering click ® to toggle to repeat mode  or set the parameter General > ScopeCharting to
True.

Signal trigger: It is also possible to use a signal from the Plots list as a trigger source. The following
steps are required to setup a signal trigger:

1. Select a trigger mode from the Select triggers pull-down menu (Figure 11):

2. Assign the trigger signal to the Plot property in the Cursor tab by selecting E‘ j-m SR
the desired plot from pull-down menu (see also Figure 14). —

3. Set the desired trigger level to the Level property in the Cursor tab. i z‘:;;:g:;g:

4. To define the pre-trigger and the post-trigger duration set Axes > TimeAxis X any Egdgeg
> Range > Minimum/Maximum in the Plot tab or click on the min/max la- P Equal
bel of the time axis (Figure 9). P Not Equal

5. The scope shows a red draggable cross-hair which can be used to set the

trigger level and the trigger time. Figure 11: Trigger
6. Press the Start button ® to activate the trigger. mode.

ServoDrive-SetupGuide_EP030 2025-05-02 16/86
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Figure 12: General tab of the

scope. The most commonly used
parameters are Default Sampling

and YAxes.

Figure 13: Plot tab of the scope.
The most commonly used parame-
ters are LineColor, Name and
Sampling Time. Selecting several
plots allows for configuring them
altogether.

Figure 14: Repeat and trigger buttons. A
horizontal draggable line marks the trig-
ger level, the vertical draggable line de-
fines the time of the trigger event. The
Plot property defines the trigger source.

It is possible to store the data of each trigger event automatically to a file on the PC with Auto-Save.
Auto-save mode can be activated by clicking the pull-down-menu to the right of the repeat icon C -
and select Auto-Save. When auto-save is active, the repeat icon shows a small blue disc symbol . The

auto-saved data from the trigger events can be accessed from TAM System Explorer by clicking File >
Open Workspace Folder > Measurements\autosave*.csv (see also [1]).
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3.3.6 Zoom and Pan
The scope supports different zoom and pan operations.

Important For zooming press Shift while defining the zoom area with the mouse or rolling the
mouse wheel.

For panning press Ctrl while dragging the Scope Area with the mouse.

Zooming or panning are only enabled when the scope is not running.

The zoom pull-down menu (Figure 15) allows to set the desired zoom behavior (horizontal/vertical/
both) and provides additional commands related to zooming:

= Zoom to plots: Sets the plot axes to the actual limit values of the m H
curves. @] Zoom

* Zoom to cursors: Restrict horizontal view to the range between the cur- | @  zoom horizontally
sors (only available when both cursors are applied). @, Zoom vertically

= Arrange Plots: Automatically assign similar types of signals to one axis @  Zoomto plots
and arrange axes without overlap of the signals. Zoom to cursors

* Fix zoom range: Set the default min/max range of the axes according & Amrange plots
the current zoom range. R

* Undo zoom: Undo the last zoom/pan operation. s

* Reset zoom range: Resets the min/max range to the default values. Reset 200m ranqe

3.3.7 Saving and Loading Scope Data Figure 15: Zoom menu
items.
Use the Scope menu to save and load plot data (Figure 16):

* The scope data can be stored as a *. csv file by using Scope > Save Plot Data....
® To open an existing data file in the scope, use Scope > Load Plot Data....
= Further information about saving and loading plot data can be found in the application note about
data exchange [1].
Scope settings can be saved to avoid time consuming reconfiguration:

= The plot settings, ranges, color and more, but without data, can be saved by executing Scope > Save
Configuration...

= A saved configuration can be loaded by executing Scope > Load Configuration.... Already configured
plots are not affected by loading a stored configuration.

To print or save an image of the scope including labels, use Scope > Print Plots..., Copy Image to Clip-
board or Save Plots as Image.... It is useful to customize the prints in advance by changing properties of
the Printing category in the Scope > General tab.
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3.3.8 Loading Templates

File | Scope | Help
> H Panning (% G- @ 2 H
=-1) Zooming » 0.08 - 54 0.6 - .
Ee Load Plot Data... -EL": E
F  SsvePlot Data... 0.06- :
Copy Image to Clipboard ':": :'__
Save Plots as Image... = EI.CI-'l—: = : = ;
Print Plots.. E g o0l g0s]
El  Analyze > x :I':I‘E_: E = .
FFT - 10- e
Clear Scope LI_: . : ;
2 Load Configuration.., 002 :-1_ -'f.:| S | pr———
| Load for X b | & From Configuration.., 1
Load for © ' General Overview 1
FH Save Configuration... . Spindle Oveniew E
Path Planner
Angle Search
Current Controller Tuning
Position Controller Disturbance Tuning
Position Contreller Follower Tuning
Sensorless Tuning

Figure 16: The Scope Menu

The first section of the scope menu is related to zooming and panning. The next
section is used to load and save plot data followed by an analysis section and a
section to reset the scope. The last section handles the configuration of the
scope.

For each axis in the Topology Tree, the scope menu offers a Load for <axis name> entry. When ex-
panded, a number of templates are available as shown in Figure 16. Each template will set up the scope
for a specific use with respect to the selected axis.

Several templates may be loaded in sequence for different axes. Use the Clear Scope menu to reset the
scope to an initial state.

The first sub-menu entry From Configuration..., allows to treat any previously saved scope configura-
tion as a template for the currently selected axis. This is manly used for configurations where all plots
refer to the same axis.
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3.3.9 Analysis

The scope incorporates the most frequently used analysis functions.

*]z] - a-T& H °

[Te]

.

' ' |
: "'-\ = : -3 .
i sy TN T N SRR, -
LT o NN,
'

(458(464.30; 2. 5257613 Mhabewrtnd e rtiomncty -

:-57—...5....'5;...5...:}r ’...ﬂ.

I |
429,08 440 460 480 0 534,28
Ly
t [ms]
ﬂt .:::::::::::::::::::::::::::::::::::::::
gisters ‘@ Module =0 Scope ] Log £
4 Cursor ¥ 5 5 Plots | Dy At |'3v|ﬂna|}rsis
— 3
e Name | (w2 -1}/ (x2 -t1]—Linear5|cpEJ

M Prifling ActualCurrentQ =
of acquired data. ... Prifling ControlQutputVeoltag T 8.6 Hz

Figure 17: Use the primary cursor to inspect single points in time. Add the secondary cursor to restrict analysis to an
interesting range. Now pull in statistical measures from the Analysis drop down.

As shown in Figure 17, the two cursors can be used to select and analyze data. Each measure is shortly
explained by its tool-tip. The first group of measurements only examine the two points at the cursors,
while the second group considers all the data in the range defined by the two cursors. A transparent
shading is shown to indicate parts of the scope not taken into account for calculations.

When the secondary cursor is inactive, the whole visible range is considered for calculation.

Analysis also features an FFT calculation. When invoked, another scope view is opened with the se-
lected data plotted against the frequency domain.

3.3.10 Formatting

The formatting and behavior of the scope, individual plots and cursors can be configured in the respec-
tive tabs.
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3.4 Triamec Workspace

When working with TAM System Explorer, different files are used or generated e.g. configuration files,
measurement data or firmware files. The Triamec Workspace helps to manage and organize these files.
Basically the workspace is a directory where all files are stored in dedicated folders. Using the
workspace simplifies file handling, backup and support. For different applications and machines it is
recommended to use separate workspaces.

U <« Tmp » TriamecWor.. v | D Search TriamecWorkspace

Mame Date modified Type Size

Configuration File folder

Firmware File folder

Leg File folder

Measurements File folder

Settings File folder

Tama File folder
lﬂ Workspace. TAMws Triamec Workspac... TKE
Titems 1 item selected =2 (=

Figure 18: Triamec Workspace in File Explorer

The following table shows the structure of the workspace.

Path Contents

'WspName' Configuration TAM and scope configurations

Doc Documentation, readme, checklists
Firmware Place device firmware files here
Log Application log files

Measurements Frequency Response measurements, plot data and pictures

Tama Tama programs

Projects Visual Studio projects, i.e. for creating Tama programs

A default workspace is generated when the TAM Software is installed. This default workspace folder is
named Triamec and it is located in the PublicDocuments folder. When TAM System Explorer is started
the first time, this workspace will be loaded. After a restart of TAM System Explorer, the last used
workspace will be loaded automatically. Use the File menu to handle the different workspaces:

= File > New > Workspace: creates a new workspace.
= File > Open Workspace: loads an existing workspace.

= File > Open Workspace Folder: opens the currently loaded workspace folder in Windows File Ex-
plorer.

= File > Recent Workspace > ... : select and load a recently opened workspace.

The currently active workspace folder is shown in the title bar of TAM System Explorer.

ServoDrive-SetupGuide_EP030 2025-05-02 21/s6



,) How to use TAM System Explorer
TAM Configuration

triamec

3.5 TAM Configuration

The parameterization of a Topology Tree is called TAM Configuration. The TAM configuration contains
the parameterization of the drives, the names of the nodes in the topology and other information.
The TAM Configuration can be saved
= persistent on the drive: If the TAM Configuration is saved persistent on the drive, this configuration
becomes active directly after restarting the drive. A drive without a persistent TAM Configuration
will load an initial configuration on start-up with default values for all registers.
= or as a *.TAMcfg file on the PC: The *.TaAMcfg file is useful to exchange a configuration between
machines of the same type or to save and archive the configuration status of a machine. It is recom-
mended to save the configuration during setup of the configuration occasionally to have a backup in
case of a problem.
The * . TAMcfq file is an XML file and can also be opened with a suitable editor (e.g. Notepad++) or
with a file comparison tool to compare two different states of the configuration (e.g. WinMerge).
Scope settings are not part of the TAM Topology Tree and have to be stored separately (see section
3.3.7).

3.5.1 Saving the TAM Configuration Persistent on the Device
Conclude the following steps to save the TAM Configuration persistent on the drive (see also Figure 19):

1. Right-click the station of the drive and select Manage Persistence ....
2. Click Save parameter permanently to store the setting to the drive.

The Manage Persistence ... dialog also allows reverting the current configuration or to disable the per-
sistence.
Remarks  During the activation of the persistence it is possible that the drive state changes to Un-
responsive for a short moment.
Persistence has to be set for each drive separately.

To reset the drive to default values, disable persistence and power cycle the drive.

Manage Persistence ].d-h,l
---@ TSD80 Choose how to act on persistent state
B If you made changes to the configuration, these will be lost after a restart or power-on of the
; B Collapse device.
2| Hide individual registers
 Save parameters permanently
55 e device will load the current parametrization during subsequent restarts.
" g Assign module... The d Il load tf p luring subseq

¥ Manage persistence... 2 Revert to persistent state
Discard the current configuration, reloading persistent parameters.

‘[j Update firmware... ) .
# Disable persistence

The device will load the factory settings during subsequent restarts.

v See details Cancel

Figure 19: Persistent TAM Configuration
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3.5.2 Saving the TAM Configuration on a PC
To save the TAM Configuration on the PC the following steps are required (see also Figure 20):

1. Open the save configuration dialog by clicking File > Save TAM Configuration....

2. The Includes panel allows to select/unselect items, which should be stored with the TAM Configu-
ration. It is recommended to use the default settings to save the configuration.

+ Registers: All parameter and information registers will be stored.

+ Tama assembilies: If a Tama program is loaded to the drive either the path to the Tama program
or the Tama code itself will be saved to the TAM Configuration (see also section 3.8).

+ Module assignments: If a module is assigned to the Topology Tree, it will be saved to the TAM
Configuration.

+ Module parameters: Parameters related to the module will be saved.
3. The Coverage panel allows to select which part of the Topology Tree should be saved:
+ If Starting from topology root is checked (default), the whole Topology Tree with all devices as-
signed to it will be saved.

+ |f Starting from tam://... is checked, only items below the currently selected item in the Topol-
ogy Tree will be saved. This is for example helpful, if only the configuration of a particular device
should be saved.

4. Clicking the Save button will open the Save As dialog.

5. After choosing a file name and clicking the Save button the progress window will pop up which
shows the progress.

6. In case of an unexpected exception, the process may be started again by using the Restart button.

‘ TestWsp - TAM System Explorer | =]
— ‘ Seoge Hélp <€E"> Save Configuration @
i New ¢ Includes Coverage
|: @ Open Workspace... /| Registers @ Starting from topology root
< Open Workspace Folder 7| Tama assemblies Starting from tam://localhost/TLO300/Tria-Link/TSD/Device/

Recent Workspaces »
¥| Module assignments

¥

Load TAM Configuration...
H Save TAM Configuration...

7| Module parameters

s Save
J A
Initialize TAM Systems e i Cancel
[dentify TAM Systems
Batch Update Firmwares... Save configuration IEI
Update Product Database...
e Writing data to file :
) Restart Saving TAM configuration succeeded
Exit
The operation succeeded. b
I | e cie ]

Figure 20: Save TAM Configuration on PC
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3.5.3 Load TAM Configuration

The following steps are required to load a TAM Configuration:
1. Open the Load Configuration dialog by clicking File > Load TAM Configuration....

2. Select a matching TAM Configuration and click the Open button. A progress window will pop up.

3. If issues are detected with the configuration, you will need to manually Start the process after
having reviewed the warnings carefully (Figure 21).

4. In case of an unexpected exception, the process may be started again by using the Start button.

Load configuration x
Reading XML file C:\Users\Public\Documents\Triamec\Configuration\TamTopology-2021-02-02T1058.TAMcfg
\
Related Triamec-788 (TSD80T-HS S/N 334) to Triamec 334.
Successful match
Press start to apply.

Figure 21: Configuration download progress window

When a TAM Configuration is loaded, the configuration is assigned to the physically existing stations ac-
cording to the following scheme:

= |f the name of a station in the tree does uniquely match with the name of a station in the configura-
tion, the configuration of the station is assigned by name.

= |f at this point there are still devices which are not assigned, the Resolve TAM configuration dialog
is opened (Figure 22).
The dialog lists all stations available in the configuration at the left column of the table.

With the pull down menu in the right column a (not jet assigned) station from the TAM Topology
Tree can be assigned to the configuration.

If the station does not exist in the current tree, select <mark for removal>.

To identify the target station, use the serial number or use the blink button. The blink button will
cause a red blink of the axes LED and system status LED.

Press Start in the Load configuration dialog to apply the assignment of the configuration.
After a new assignment of the stations it is recommended to save the TAM Configuration.

*

*

*

*

*

*

ServoDrive-SetupGuide_EP030 2025-05-02 24/36



,) How to use TAM System Explorer
TAM Configuration

triamec

File Scope Help

2 H[9] « &-@-9 & [
E-1) Topology I a0

E|,H PC-DG | |5ag configuration @
o B8 TL030

9{} Tr

E‘° Reading XML file C:\tmp\TamTopology-2019-05-06T1643. TAMcfg

- B
Resolve TAM configuration ﬁ

A part of the TAM configuration could not be related. Please map existing targets, or mark items for
removal.

Location:  Topology/

Configuration Target
TSD8OT-HS TSD803_XY, S/N 42, LN 0 [mone; -]
|| | TSDBOT-HS TSD804_7B, S/N 33, LN O
. <marked for rermoval>

TsDa02_7B

TSDBE01_XY

e

Figure 22: Resolve configuration mismatch.

If the station name does not match or is not unique, and the serial number of the device does
match, the configuration is assigned by serial number.

= Stations that can't be assigned by name or serial number are assigned by station type, if a unique
assignment according to the station type is possible.
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3.5.4 Working Offline
Even when you don’t have access to a drive or the machine, you can open a TAM Configuration offline:

= By opening the TAM Configuration in the Windows Explorer.
= Using the menu File > Open Configuration Offline...

The application then simulates the topology tree as specified in the configuration. The window title is
set to the name of the TAM configuration file.

Figure 23: In order to make it clear for everyone, the status bar changes to dark mode in offline mode, and an indi-
cator is visible on the right.

The simulation only reproduces a few aspects of the real system. Among other features, this is a conve-
nient way to edit the configuration, including Controller Tuning.

3.5.5 Transferring a TAM Configuration

It is often required to transfer a TAM Configuration from one machine A (MA) to another machine B
(MB) of the same type. This can be done by executing the following steps:

1. Give the stations of MA a meaningful name e.g. Station1_XY, Station2_ZB etc.
Save the configuration of MA on the PC.

Connect to MB and load the configuration.

Solve the configuration mismatch by using the serial number or the blink button.
Save the configuration for MB on the PC and persistent on the drive.

vk wN

3.6 TAM Snapshot

A TAM Snapshot represents the state of a drive at a specific time instance. The state is represented by
register values. A TAM Snapshot is thus closely related to a TAM Configuration, since it also contains all
Parameters of a drive, but holds additional information such as Signals or Commands. A TAM Snapshot
is generated alongside TAM Dump Files in a Dump Event, which occurs either due to an error or when
manually triggered by the user. A TAM Snapshot can be opened offline with the TAM System Explorer.
When a TAM Snapshot is opened, the binary file is additionally saved as a JSON to make the file read-
able and to allow differentiating TAM Snapshots more easily. It is possible to generate a TAM Configura-
tion from a TAM Snapshot that has been loaded to the TAM System Explorer by saving the current con-
figuration as described in 3.5.2.

3.6.1 Trigger a TAM Snapshot

In order to trigger a TAM Snapshot manually, a Dump Event event has to be triggered, which can be
done by clicking on the camera symbol depicted in Figure 24 or by pressing F7.
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@ « Acknowledge Errors =

Figure 24: Bottom menu with “Record Dump” (left) and “Create Report” (right) button

3.6.2 Save TAM Snapshot to PC
A TAM Snapshot can be saved in two ways:

1. Generate a Report. This can be done by clicking the “Create Report” button shown in Figure 24.

2. Download directly from the device’s web interface. You can open the web interface of a device by
right-clicking it and select Browse, refer to Figure 25. After having opened the device’s start page,
go to directory in order to find all TAM Snapshots available. Select the most recent one by check-
ing the timestamp.

Collapse
Hide individual registers

Assign module...

e Y TC

Browse

Manageaasic saiams .
_~ Access this device with your default web browser. |
COangLut:' sarety...

A o o ] Br‘

e Y SE

e Y SE

- 1/0 ANTE)

Update firmware...

Figure 25: Browse a device’s web interface

3.6.3 Open a TAM Snapshot
A TAM Snapshot can be opened in two ways:

1. Double-click a .TAMsnap file
2. Load a.TAMsnap file via the context menu shown in Figure 26.

File ‘ Scope Help ,O tam://localhost/
New >

m1

Open Workspace...

TR

Open Workspace Folder
Recent Workspaces »
Load TAM Configuration...

Save TAM Configuration...  Ctrl+S
Open Offline

Protect Setup

w

TAM Configuration...
Device Snapshot...

v

b B{@lm @

[ S [

Figure 26: Open a TAM Snapshot via the context menu
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3.7 Firmware Update

This section explains how to find a suitable firmware and how to download the firmware to the device.

The newest firmware release can be downloaded from the Triamec web page:

1. Go to www.triamec.com > Support > TAM Firmware:

2. Open the web-page matching the product type of your device (e.g. > TSD Series). If the product
type of your device is not known, you can identify it by clicking the station of the device in the
Topology Tree. This opens the property page in the General tab as shown in Figure 27. You will
find the type of the device under Product Information. The property page also shows the cur-
rently installed firmware version and the product revision which could also be relevant for the se-
lection of the firmware.

3. Check the release notes for relevant changes of the firmware.

4. Download the *. zip file with the firmware package and unzip the file.

# [eone]

_."?---E}Szevice & General @ Registers ‘@ Module ] Scope i3] Log
+w¢ Registe, == 2l |
@ Tama [ 1L dentification )
Device serial number TMS00306
Mame Laser
N v Product information Type: TSD80T-HS Rev: 4 Firmware: 4.4.12
Allow update when op False
is l. A State Description Servo drive for two motors with B0V voltage
X s s ReadyT Firmware release 4412
e s s ReadyT Manufacturer Triamec Motion AG
Product family TSD20.130
Product name TSDB0T-HS o
Product family

An identifier needed for choosing a file for a firmware update.

Figure 27: Station Properties.
The product information shows the type, the product revision and the firmware version.

Execute the following steps to download the firmware:
= Make sure that all axes are disabled and STO is not active.

= Right click the device to open the context menu (Figure 28).

* From the context menu choose Update Firmware ....

= Select the desired firmware and click open. A filter assures, that only compatible files are selectable.
If no firmware file is selectable, make sure you have downloaded the correct firmware package.

= The Firmware File Download window pops up. Click Start to initiate the download. The green bar
will show the progress of the download.

= After the download succeeded, press Close to close the window.

Tria-Link adapters don't have a station node, they display the Update Firmware ... context menu entry
in their adapter node.
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5Py Link 0 5 10 15 20
5@ Laser - : - —
—_B_} E General % Registers “#% Module 7] 5o
+‘@ Regi Collapse

= ] Tam Hide individual registers

Motor base configuration
@ Astsign module..
[=  Startup settings...

Update firmware...
A 5 5 Reaayre

’ﬁ'-xis . A St

Figure 28: Firmware download via the station node.

Important If the replaced firmware version is older than 4.7 or the TAM System Explorer version is
older than 7.10 a power cycle of the drive is required to activate the new firmware!

Warning Safe Torque Off must not be activated before and during a firmware download.

3.8 Tama Program

A Tama Program is a piece of software which can be loaded to a Triamec Servo Drive during run time
and which is executed with up to 10kHz in real time. With a Tama Program it is possible to extend the
drive firmware with user specific implementations. Typical applications with Tama Programs are:

= Stand alone control of a drive
Adaptive gain controller
Adaptive feed forward

= Compensation algorithms

= etc.

The Tama Program has access to all registers in the TAM register tree. This allows full control over the
axis and the drive. The Tama code is typically written in C#. See [6] for a detailed documentation of how
to implement and use Tama Programs.
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3.9 Setup Protection

As a system supplier, you can protect your setup with a password. This can reduce support incidents
due to modifications by unauthorized personnel.

Using the menus under File > Protect Setup, you can enable and disable protection. For the purpose of
servicing, you can also disable protection temporarily, without changing device state, so you don’t need
to remember to enable protection in the end. This state is maintained only until the application is
closed.

Menus and areas not available due to the protection receive a [+ protection icon and an explanatory
tool-tip or label, respectively.

Remark This is not an all-purpose solution against deliberate tampering. Only the TAM System Ex-
plorer protects the setup using this mechanism. Customer written applications may con-
sider setup protection, but don’t need to.

Caution You must manage the password such that it doesn’t get lost. If you forget the password,
you will need to contact Triamec support.

Caution Since the password is hashed with a weak algorithm, don't reuse a sensible password.

3.10 Global Keys

The following keys are always active when TAM System Explorer is active.

Key Effect
F5 Start/Stop Scope. This corresponds to the ® button in the Scope toolbar.
F6 Arrange plots in the Scope. This corresponds to the & button in the Scope toolbar.
F12 Emergency switch off all power sections. You may also click the @ button located on
the left of the axis monitor.
Caution Switching off the power section of a drive during motion may damage the axis.

Pause/Break Emergency Stop of all active axes. You may also click the &/ button located on the left

of the axis monitor.
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4 Plug-In Modules

The whole functionality of a Triamec device can be accessed directly by interacting with the registers of
Topology Tree. However, this can be rather extensive and complicated. To simplify dedicated tasks, plug-
in modules can be assigned to the Topology Tree. These modules provide a graphical user interface
which allows to interact with the device while reading and writing of the registers is handled by the
module.

- @ TSD80 --@ TSD80
=N | Devicel = Ej Device
+-§ B Collapse i @-'§ Register
)} 2| Hide individual registers i & Tama Manager
A% T i @8 Axis Grou
& Assign module... | ?* ;___:p
P> Manage persistence... i - Axic 1
47  Update firmware... -4 TOR (&)

Figure 29: Axis module assignment.

With the following steps, an Axis or AxisGroup module can be assigned to a device (Figure 29):

1. Right click the device to open the context menu of the device.
2. Click Assign module...

3. The module is assigned to the Topology Tree. To access sub modules, unfold the module node in
the Topology Tree. The user interface is shown in the Tab Panel in Module > View. Parameters as-
signed to the module are shown in Module > Parameter.

To remove a plug-in module open the context menu of the module, then click Remove module.

4.1 Axis Module

The axis module can be used to execute basic movements of the axis. =% i Group)
For dual-axis drives an Axis Group-module should be added to the - Aois 0

Topology Tree. Unfold the module-node and select the desired axis. The ﬁ E::::;g Manager

user interface of the axis is then shown in the Tab Panel in Module > & Bode Tuning
View (Figure 31). If the Axis node is expanded further, additional tools i Avis 1
like Frequency Response Tuning are accessible.

Figure 30: Unfolded Axis
Group

ServoDrive-SetupGuide_EP030 2025-05-02 31/86


https://triamec.com/

D)

triamec

Plug-In Modules
Axis Module

Activation

® @ & @ ON
Detach Reset Disable Home Homing: HomingDone
Standstill
Motion o
47.108335
Mook A 0o M
Dynamic
Move AB: B I:l ° M | [ Loop after 0% ms Vel. 10/~ %
“ 7 . M » @ Acc. | 1003 %

Set Positio?
st s | -

Figure 31: User interface of the axis module

The axis module offers the following controls to interact with the axis (see also Figure 31):

1.

9.

*

*

*

*

Attach/Detach: In case the Attach button is shown, this button needs to be pressed in order to
enable the controls of the module. This button prohibits commands from the superior control sys-
tem (e.g., EtherCAT) to allow the module to control the axis. Pressing the button sets Axes[].Com-
mands.General.OverrideControlSystem to 1. Release the button (Detach) to return control to the
superior control system.
Reset: The Reset button can be used to reset pending errors or warnings. If the reset was success-
ful, the drive returns to the Disabled state. If the reset was not successful, additional actions are
needed by the user depending on the type of the error/warning.
Enable/Disable: This button is used to enable or disable the axis. After the axis is successfully en-
abled, the axis state is Standstill. If Disable is pressed, the axis-state will change to Ready-
ToSwitchOn or Disabled.
Home: If a homing sequence is configured (see chapter 5.2.11), you can initiate it with this button
in the Standstill state.
Status indicator.
At the top right corner the following information is displayed:

The axis name (Axes[].Information.AxisName)

The homing state (Axes[].Signals.Homing.State), if homing is configured

The axis state (Axes[].Signals.General.AxisState)

The actual position (Axes[].Commands.PositionController.MasterPosition)
Move to A: Pressing this button causes the axis to move to the position specified in field A. Use
the corresponding M-button to load the actual position to field A.
Move AB: Pressing this button causes the axis to move towards position A and then to position B.
Use the corresponding M-button to load the actual position to fields A or B. If the axis is already
located at A, only a move to B is executed. If the Loop After-checkbox is checked, the move se-
guence A B will be repeated until another move button or the stop button B is pressed. The wait
time field at the right is used to set the delay at A and B before the next move starts.
Jog and Stop buttons:
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¢ Press the stop button B to terminate an ongoing move, or abort an ongoing homing sequence,
respectively.

+ Continuous jog negative 4 / positive ®: Pressing this button starts a continuous move. The move
will run until another move button or the stop button B is pressed.

* Jog negative M4 / positive MI: While pressing this button the axis moves in the desired direction.
The move will stop when the button is released.
10. Dynamics: These two fields can be used to reduce the dynamics of the move.
+ Vel.: This field specifies the velocity used for the move relative to Axes[].Parameters.PathPlan-
nerVelocityMaximum.
* Acc.: This field specifies the acceleration used for the move relative to Axes[].Parameters.Path-
Planner.AccelerationMaximum.

11. Set Position: Pressing Set Position sets the actual position to the value specified in field S. If appli-
cable, homing will be invalidated.

Important If the Activation panel shows an Attach button, this button needs to be pressed in order
to enable the controls of the module. Release the button (Detach) to return control to
the superior control system.

Sub-Modules

* Frequency Response Tuning: See chapter 4.2 Frequency Response.

4.2 Frequency Response Module

The Frequency Response module is used to measure the dynamic characteristic of an axis in frequency
domain and to tune the controller based on this measurement. The following sections describe the
steps required.

Find the Frequency Response module in the Axis Group module and open the View tab. The View tab
contains the following buttons:

= Measure... opens the Frequency Response Measurement application. The application allows to
configure and to execute the measurement.

= Tune... opens a Frequency Response measurement in the Frequency Response Tuning editor. The
editor allows to modify the controller parameter and directly visualizes the effect of the modifica-
tion.
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Figure 32: Frequency Response module.
4.2.1 Frequency Response Measurement

The Frequency Response measurement allows to acquire the frequency response of the axis. This mea-
surement is required for Frequency Response tuning and therefore has to be executed first.

4.2.1.1 Preparation:

Warning The Frequency Response measurement causes the axis to move. Therefore a safe environ-
ment and setup is required and the drive has to be configured correctly.

The following parameters must be set correctly. An incorrect parameterization could influence the mea-
surement results or damage the motor. See also section 5.2 on how to configure these parameters.

= Axes[].Parameters.Motor.Type

= Axes[].Parameters.Motor.InvertDirection

= Axes[].Parameters.Motor.PolePairs

= Axes[].Parameters.Motor.EncoderCountsPerMotorRevolution
= Axes[].Parameters.Motor.PeakCurrent

= Axes[].Parameters.Motor.NominalCurrent

= Axes[].Parameters.PositionController.Encoders[].Type

= Axes[].Parameters.PositionController.Encoders[].InvertDirection
= Axes[].Parameters.PositionController.Encoders[].Pitch

= Axes[].Parameters.PositionController.OutputLimit

= Axes[].Parameters.Commutation. ...

= Axes[].Parameters.CurrentController.OutputLimit

= General.Parameters.EncoderTopology

= General.Parameters.DcBusVoltageUpperLimit

= General.Parameters.DcBusVoltageLowerLimit

Important Make sure that the axis is moving freely during the measurement. If the axis is touching
an obstacle or an end stop, the measurement will not reflect the correct behavior of the
axis.

To avoid moving against an end stop e.g. if the direction of the axis is vertical, a soft material like
foamed plastic can be used to underlay the axis. If the axis is equipped with a brake, the brake has to be
released during the measurement. In case of air bearings the correct air pressure must be applied.
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4.2.1.2 Measurement Setup

To start the measurement click the Measure...

plication as shown in Figure 33.

A

Method Open Loop

Frequency 40.63 Hz (Frame 285) acquired

50000
20.0
- 24000
300

Optimized

®

Start Stop

Wear ear protection!
You cannot notice dangerous high-frequency noise at first.

Exit

0.2 7

0.1

-0.1

-0.2-

Plug-In Modules

Frequency Response Module

button (Figure 32). This opens the window with the ap-

0.02

0.02

0.02

Figure 33: Frequency Response measurement application.

The following parameters can be set:

Qutput [V]
0.04 0.06 0.08
ActualCurrentQ [A]
0.04 0.06 0.08
Position [°]
0.04 0.06 0.08

0.1

0.1

0.1

0.12304

0.12304

0.12304

* Frequency scan: Set up the frequency range and the resolution of the measurement in the fre-

ServoDrive-SetupGuide_EP030

guency domain.

+ Measurement frequency: This parameter defines the rate of data logging (default 50 kHz).
+ Minimum Frequency: This parameter defines the lower limit of the frequency range (default

20Hz).

+ Maximum Frequency: This parameter defines the upper limit of the frequency range (default
24kHz at a measurement frequency of 50 kHz). This parameter is reset to the maximum possible
value when changing the measurement frequency.

¢ Number of samples: This parameter defines the resolution of the measurement in the fre-
quency range. Depending on the 'Spacing' parameter the range defined by 'Minimum Fre-
quency' and 'Maximum Frequency is divided into the number of 'Frequency Steps'. With a
higher number of frequency steps, the measurement takes longer but will provide a higher reso-
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lution which is especially crucial to capture sharp resonances (default 300 samples).

* Spacing: Defines how the range between Minimum Frequency and Maximum Frequency is
sampled. Optimized shortens the measuring time while maintaining the quality of the measure-
ment. Alternatives are Logarithmic or Linear spacing (default Optimized).

= Method: This parameter defines the state of the controllers during the measurement as well as the
measuring points where the frequency response is measured. Closed Loop methods require a sta-
ble setting for the position controller and the current controller. Choose the method as called out in
the setup procedure (default Open Loop).

= Excitation limits: These parameters specify the maximum allowed amplitudes for each measuring
point. The names of the parameters change according to the respective measuring point. The fol-
lowing explanations about maximum and default values apply to each possible measuring point ac-
cording to its unit. Changing the method reverts these parameters to their default value.

¢ Output: This parameter defines the maximum allowed amplitude of the voltage signal. The de-
fault value is half of the output limit according register Axes[].Parameters.CurrentController.Out-
putLimit.

+ ActualCurrentQ: This parameter defines the maximum allowed amplitude of the current. The
default value is half of the nominal current of the motor according register Axes[].Parameters.-
Motor.NominalCurrent. The value is limited by Axes[].Parameters.PositionController.OutputLimit

+ Position: This parameter defines the maximum allowed amplitude of the position. The default
value is chosen according to the position unit.

Warning The excitation limits are used to deduce the amplitude of the harmonic excitation of the
axis. This parameters must be set with caution, as too big an excitation can damage the
axis. It is recommended to start with small values for the amplitudes (especially for the
current) and to increase the values carefully until a sufficient signal to noise ratio is
reached.

A Frequency Response measurement can generate loud noise also in frequencies that are
not perceived by the human ear. Wear hearing protection and keep animal companions
away.

4.2.1.3 Measurement
The following controls are available for the execution of the measurement:

= Attach/Detach: Take or release control of the axis.

= Start: When the 'Start' button is pressed, the measurement starts.
= Stop: The measurement can be aborted with the 'Stop' button.

= Exit: Close the Frequency Response measurement window.

After attaching, start the measurement by pressing Start. During the measurement the amplitude of
the output signal is adapted in such a way that amplitudes of the states (voltage, current and position)
are as big as possible but do not exceed the specified maximum.

Once the measurement is done, the Frequency Response Measurement Result window is opened (Fig-
ure 34) which allows to examine the quality of the signals.
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Figure 34: Frequency Response measurement result.

For later use of the measurement with the Frequency Response Tuning tool, the measurement has to
be saved by clicking the Save button. The measurements are saved as a * . csv file. It could make sense
to adjust the default file name or path for better identification of the measurement.

4.2.1.4 Remarks
For a first recording it is recommended to use the following frequencies settings:

= Minimum Frequency = 20 Hz; Maximum Frequency = 24000 Hz; Number of samples > 300
In some cases it is required to have a higher resolution in the frequency domain, for example for axes
with critical resonances. In this case, you can repeat the measurement in a reduced window of the fre-
guency domain, but with a high number of samples. Multiple measurements can be shown overlaid
later in Controller Tuning.

The dynamic behavior of a machine may change depending on the location of the axes. Therefore it is
recommended to do the measurement at several locations in the machine workspace and save them as
*.csv files. For the later tuning of the axis, multiple measurements can be loaded into the Frequency Re-
sponse Tuning tool (see section 4.2.2).

Generally the quality of the measurement increases with bigger amplitudes (especially with low resolu-
tion encoders or high friction), but the restrictions of the machine must be considered when increasing
the maximum values.

Normally, the phase plot of response X/I should show a phase shift of about 180° at low frequencies. If
the phase shift is closer to 0°, the parameter Axes[].Parameters.Motor.InvertDirection might have to be
altered (see also section 5.5.1).

If the excitement of the axis varies depending on the position of the motor probably one of the follow -
ing parameters is not set correctly:

= Axes[].Parameters.Motor.InvertDirection
= Axes[].Parameters.Motor.PolePairs
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= Axes[].Parameters.Motor.EncoderCountsPerMotorRevolution

In some cases it is required to do a closed loop measurement e.g. to avoid drifting of the axis. In this
case the Method property can be set to Closed Loop. A closed loop Frequency Response measurement
requires stable parameterization of the position controller.

When two encoders are configured for the axis (e.g. dual-loop), the signals from both encoders will be
acquired.

It is possible to further customize the Frequency Response measurement. For example to measure cross
coupling between two axis or to measure a signal from an external sensor read by an option module.
This is explained in the dedicated FrequencyResponseConfig repository at GitHub.

4.2.2 Controller Tuning

The saved Frequency Response measurements (see section 4.2.1) can be used to design and optimize
the position and current controllers with the Frequency Response Tuning editor. The following steps
are required to open the saved Frequency Response measurements in the editor:

= To open measurements in the editor click Tune Controllers... (Figure 32).

= Select one or several Frequency Response measurement files and click 'Open'. Use Ctrl or Shift to
select more than one file. Make sure the measurement corresponds to the selected axis in the
Topology Tree.

= The Frequency Response Tuning editor is opened and the frequency response of the current loop is
displayed. If the plots are empty, the controller gain may be zero. Set the gain to a value > 0 in this
case.

4.2.2.1 Editor Window

The editor consists of the following items (see also Figure 35):
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W Sample_Bode-Measurement_Linear-Axis
Figure 35: Frequency Response Tuning editor with current controller and Bode plot selected.

1. Title Bar: In the title bar, the name of the selected axis is shown. Make sure the axis is consistent
with the loaded measurements.

2. Select Controller: This radio button can be used to switch between different controllers e.g. cur-
rent loop or position loop.

3. Control Parameters: The parameters of the selected controller loop are displayed and can be
modified. If a parameter is modified, the values are stored like prepare values in registers: The
background changes its color to orange, indicating a modified but not yet committed parameter.
After each change, the Bode and Nyquist Figures are recalculated. When some parameters are il-
legal, no data is drawn. With the button Estimate Controller an initial parameter set can be calcu-
lated (see section 5.4.4 and 5.4.8). The button Estimate FFA can be used to estimate the accelera-
tion feed forward (see section 5.5.4).

4. Commit Parameters, Revert, Compare:
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+ Commit Parameters: Modification of parameters does not affect the configuration of the drive.
Only when the commit button is pressed, the drive configuration will be updated with the modi-
fied values.

+ Revert: This button is used to reset the parameters to the actual drive-configuration.

+ Compare: Press and hold this button to show the transfer functions of the actual drive-configu-
ration. This can be used to compare modified parameters with the actual drive setup.

5. View: Reset Zoom can be used to reset zoom and pan operations.
Checking Wrap Phase reduces the phase range into [-360,0]° in the Bode plot. It has no effect in
the Nyquist plot.

6. Bode / Nyquist: In the top right corner, the display mode of the frequency response can be se-
lected:

+ Bode: The amplitude response and the phase response of the axis are plotted. The signal colors
match to transfer functions as following (see also Figure 36).

* Red: calculated open loop frequency response based on the measurement and the controller
parameters

* Blue: controller transfer function

* Green: calculated closed loop frequency response based on the measurement and the con-
troller parameters

A _ | Controller | _ | Plant _
=/ Gr " | Gplant -
Gopen
Gclosed

Figure 36: Signal colors according to transfer functions in the control loop.

* Nyquist: The red curve shows the open loop frequency response in the complex plane calculated
based on the measurement and the controller parameters.

7. Cursor: A cursor is shown together with a label at the top left corner of the graph. The label dis-
plays the frequency, gain and phase at the cross-hair location. To select a different signal, the
cross-hair has to be dragged to the new signal. At the beginning, the cursor might be hidden at
the boundaries of the graph.

8. Legend: The first three legend items show the colors for controller (Gr), closed (Gclosed) and
open (Gopen) loop curves. For each loaded measurement, a legend item is generated, showing
the file name and the curve colors. Hovering over the legend items will highlight Gopen and
Gclosed loop curves from the respective measurement. If many files are loaded, the legend will
wrap. In this case the size of the legend frame may be adjusted by dragging the upper border or
the vertical scroll-bar at the right can be used.

You can add and remove measurements via the legend.

Remove a measurement by clicking on the X button which fades in when hovering over the leg-
end item.

Add measurements using the + button on the right side of the legend. In the Open Frequency Re-
sponse(s) dialog set the radio button either to Append in order to add the measurement to the
loaded measurements, or Replace to only load the new measurement (Figure 37). The same dia-
log is shown when repeatedly using the Tune... button in the Module View tab.
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Figure 37: When opening Frequency Response measurements, you can choose
whether to append new data, or to replace all measurements currently shown in the
Frequency Response tuning window.

4.2.2.2 Zooming and Panning

This section describes how to zoom and pan the plot area:

= Press Shift and left mouse-key while defining the zoom area with the mouse.

= Press Ctrl and left mouse-key to pan the plot area.

= To undo the zoom area: press Shift or Ctrl and right mouse-key to reset the zoom area.
= Zooming is also possible by pressing Shift and turning the mouse-wheel.

= |f zoom is applied, the cross-hair can be out of scope. Zoom out is required (e.g. Shift + scroll

wheel).
= Reset zoom using the respective button.
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5 Drive Configuration

This chapter explains how to configure the registers in the Topology Tree to commission a servo axis.
The commissioning steps are also visualized in chapter 7.

5.1 Preparation

If the servo drive was already used for a different setup it is recommended to reset it to default settings
right-clicking the device node in the register tree, then clicking — Manage persistence... — Disable per-
sistence and rebooting the drive.

5.1.1 Required Data

Before commissioning a servo axis, axis specifications are needed. This section gives an overview of the
required data. If desired, additional values can be written to the Axes[].Information registers (see also
section 3.1.4).

Motor
Specifications found in the motor data sheet:

= Type of motor: dc/ac, synchronous, linear/rotational
» Peak current?
* Nominal current?
= Thermal time constant or current square time constant (or peak current duration)
= if rotational motor
+ Torque constant’
* Number of pole pairs (check if number of pole pairs or if number of poles is specified)
* Screw pitch if axis with lead screw
= if linear motor
+ Force constant?
* Pole-pair pitch (distance between two north-poles or two south-poles)
= if motor temperature is observed by the drive:
* Type of sensor
¢ Temperature limit

2 Important: Consider if the current is given as peak value or as root mean square value (RMS). Contact the manufacturer of the motor
if this is not declared in the data sheet.
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Encoder
Specifications found in the encoder data sheet:

= Encoder pitch or encoder counts per motor revolution
= Max allowed encoder speed

Additional information about the axis
The following aspects of the axis should be considered before commissioning an axis:

= How should the axis be named (e.g. Axis_X, Axis_Y ...)

= Total inertia of the axis

= Topology of the axis (linear/rotational, single-loop/dual-loop, horizontal/vertical, ...)

= How are the encoders connected to the drive (which connector of the drive is used to connect the
encoders)

= How is the motor connected to the drive (which connector of the drive is used to connect the mo-
tor)

= How will the axis be referenced

= Move range of the axis

= Dynamic specifications of the axis (max velocity, max acceleration, max jerk)

= How should the axis be controlled (TwinCAT, stand-alone with Tama program, PC-application with
TAM API)

= Safety considerations (STO, ...)

= Additional requirements ...

5.1.2 Naming of Stations and Axes

To easily identify the related physical axis, it is recommended to change the station name and the axis
name to a meaningful expression. For example if AxisO is used to drive the X axis and Axis1 is used to
drive the Y axis, name the station Station XY and the axes Axis_X and Axis_Y. See sections 3.1 and 3.2
for how to rename stations and axes.

—lﬂ Topology
5.g8 PC-DG
4.8 Unknown
5.£% Simulation (NET CLR)

+ & Register
@ Tama Manager
+- 'l Axis Group

Axis L. A State
. ReadyToSwitchOn
ReadyToSwitchOn
Figure 38: Example for renaming of
stations and axes.
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5.1.3 Units

The unit for the position can be set with register Axes[].Parameters.PositionController.PositionUnit. For
linear axes m or mm and for rotational axes turns, degree or rad can be set.

Note It is recommended to set the unit for the position prior to commissioning the drive. All
other dimensions are defined according the International System of Units (Sl).

5.2 Initial Setup of the Register Tree

This section describes the initial setup of the parameter registers. It is good practice to fill the registers
from top of the tree to bottom while leaving not yet known parameters (e.g. controller gains) out for
later configuration. This section follows this practice and explains how to set the relevant parameters
for a common application. Parameters not covered in this section keep their default value. See section
3.1.1 on how to write and commit parameters. For people with experience in Triamec drive configura-
tion, Figure 71 can lead you through the setup.

Remark If the drive was used for a different application before, it is recommended to reset the
registers to default values (see section 3.5.1).

The register Tree contains four nodes:

= General: The General node contains registers which are relevant for the drive but not dedicated to
an axis.

= Axis: The Axis node contains registers which are related to the axis.

= Application: These registers are only relevant in conjunction with a Tama program and are not cov-
ered in this section.

= Gantry: The Gantry node contains registers which are related to the Gantry Axes.

The following parameters must be configured for an initial setup:

5.2.1 General.Parameters

= DcBusVoltagelowerLimit, DcBusVoltageUpperLimit: This values are used to monitor the DC bus volt-
age (General.Signals.DcBusVoltage). If the measured DC bus voltage is out of the specified range, a
DcBusVoltageOutOfRange error is issued.
It is recommended to set the range plus minus 10 to 20 % of the DC bus voltage. For applications
with a TP or TPDC device the upper limit has to be set slightly above the setpoint voltage of the
brake resistor. The setpoint of the brake resistor can be found in the hardware manual of the TP or
TPDC device. For the TSP700 drive the brake point is set internally to 10V below the value of DcBus-
VoltageUpperLimit.

= EncoderTopology: The EncoderTopology is only different from Standard if the encoders are con-
nected to the drive in a nonstandard way e.g. if option modules are used (see also [7]).
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= PowerSupply.SinglePhaseOperation: With the TSP700, the monitoring of the power supply phases
can be changed. If all three phases must be present, the parameter must be set to False. If only one
or two phases are permitted, the value must be set to True.

= PowerSupply.ExternalBrakeResistor: With the TSP700, you can define whether the internal or an ex-
ternal braking resistor should be used. If the internal braking resistor is used, the parameter must
be set to False. If an external resistor is used, the value must be set to True.

5.2.2 Axes[].Parameters.Motor
This node contains registers related to the motor.

= Type: Servo axes mostly use three-phase synchronous motors for both linear and rotational axes.
Set Type to SynchronousAC in this case. In case of a DC-motor (e.g. brushed dc-motors, voice-coil
motor...) set Type to DC. Stepper motors might have only two phases, select SynchronousT-
woPhaseAC.
= BrakeReleaseAction: This parameter allows to select a digital output which is set to release the
brake when the axis is enabled.
+ With 'SetOutl' the digital output O1 is set. Also the Brake output of the motor connector X40 is
set.
+ With 'SetOut2’ the digital output 02 is set.
+ For more information on how to connect the brake see the corresponding hardware manual.
= BrakeHoldTime: If there is a significant delay between the instance when the brake output is reset
and the instance when brake is applied mechanically, the BrakeHoldTime can be used to compen-
sate this delay. The axis will remain enabled for the duration of BrakeHoldTime to avoid a move-
ment of the axis during this delay.

-8

BrakeéHoIdTlme

Phasing I : Enabled

LI5S XY

DigitalOut1

Disabled IW

Brake released
i Brake applied

e e e g g - =3
0 1000 2000 3000 4000 5000 6033 kL O‘C\C\ SQ‘DO 93‘00 10000
t [ms)
L) AO_AKM22E ActualCurrentQ o Rl A0 AKM22E AxisState o hal AO_AKM22E DigitalOutl |17 AO_AKMZ22E ActualCurrentD
Figure 39: BrakeHoldTime: Timing diagram of the brake output with BrakeRe-
leaseAction = SetOutl and BrakeHoldTime = 1s.

= |nvertDirection: With this parameter it is possible to alter the electrical direction of the motor.
The position controller requires, that the electrical direction of the motor has the same orientation
as the direction of the encoder. If the orientation is opposite, the parameter InvertDirection has to
be altered to align the directions. If the encoder direction is changed, flip the motor InvertDirection
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too.
An incorrect setting of this parameter is often the cause for problems when the motor is enabled
the first time. The following symptoms could indicate an incorrect setting which requires to alter
the parameter InvertDirection:?
* The Frequency Response measurement shows a phase shift of about 0° or a multiple of 360°. A
phase shift of -180° is expected if the alignment is correct.
* For a 3-phase motor, if the excitement of the axis varies depending on the position of the motor
during the Frequency Response measurement.
* The enabling fails immediately after the phasing of the axis.
+ If a current causes the axis to move in opposite direction.

encoder encoder
count U count
direction direction
Vv = \V z
electrical electrical
motor motor
direction w direction
Figure 40: If the electrical direction of the motor is al- Figure 41: If the electrical direction of the motor is
ligned with the encoder count direction the parameter  oposite to the encoder count direction the parameter In-
InvertDirection has to be set to False. vertDirection has to be set to True.

= PolePairs: This value has to be set to the number of pole pairs according to the data-sheet of the
motor. In case of a linear motor or a DC-motor, this value is set to 1. In case of stepper motors, se-
lect the number of steps and divide it by 4.

= EncoderCountsPerMotorRevolution: This parameter describes the number of encoder lines per mo-
tor revolution. The definition of this parameter depends on the type of motor (linear/rotational)
and the type of encoder (absolute/relative). See also [7] for more information.

+ In case of a rotational motor and a relative or analog encoder®, EncoderCountsPerMotorRevolu-
tion corresponds to the number of encoder lines per motor revolution.

+ In case of a rotational motor and an absolute encoder without analog signals®, set Encoder-
CountsPerMotorRevolution to 1.

+ In case of a linear motor, set this parameter to the number of encoder lines per pole pair pitch:
EncoderCountsPerMotorRevolution = round(PolePairPitch / EncoderPitch). The resulting value
has to be rounded to the nearest integer value. The value for the PolePairPitch can be taken
from the motor data sheet. The value for EncoderPitch is taken from the encoder data sheet (see
also Figure 43).

= PeakCurrent: This parameter has to be set to the peak current specified in the data sheet of the mo-
tor. If the absolute current applied to the motor exceeds the value of PeakCurrent a MotorPeakCur-
rentLimit error is issued.
For three-phase motors, consider if the current is given as peak value or as root mean square value
(RMS). If the value is specified as root mean square, multiply it by v2=1.414

3 Similar symptoms are caused by incorrect configuration of InvertDirection, EncoderCountsPerMotorRevolution and PolePairs (see also
section 5.5.1).

4 IncrementalRS422; IncrementalTTL; Analog; AnalogEndat; AnalogBissB; AnalogBissC:

5 DigitalEndat; DigitalBissB; DigitalBissC; DigitalTamagawa; DigitalNikon
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= PeakCurrentWarning: This parameter can be used to rise a warning if a certain current level is ex-
ceeded. The warning level is defined by a factor 0...1 relative to the value of the register PeakCur-
rent. If the factor is 1, the warning is disabled.

= NominalCurrent: This parameter has to be set to the nominal current specified in the data sheet of
the motor. If the averaged current of one of the motor phases exceeds this value, a Motorl2t error
is issued.
For three-phase motors, the value has to be entered as root mean square value (RMS) which is also
the scale used in most data sheets.

= NominalCurrentWarning: This parameter can be used to rise a warning if a certain current level is
exceeded. The warning level is defined by a factor 0...1 relative to the value of register NominalCur-
rent. If the factor is 1, the warning is disabled.

= CurrentSquareTime: This parameter is used for the calculation of the i2t current and corresponds to
to the Thermal Time Constant of the motor. The Thermal Time Constant should be specified in the
motor data sheet. If the Thermal Time Constant is not available but the Peak Current Duration is
specified, the CurrentSquareTime can be calculated with the following equation:

— PeakCurrentDuration

CurrentSqareTime =

2-NominalCurrent®
In|1—

PeakCurrent?

If both values aren't specified, set this value to 10-30s for an iron-less motor and 60-600s for an
iron-core motor.

Warning  The limitation of the current (NominalCurrent, PeakCurrent, CurrentSquareTime) must
be configured correctly before the drive is enabled the first time. Incorrect settings could
damage the motor.

5.2.3 Axes[].Parameters.PathPlanner

This node contains the parameters relevant for the internal path planner. These parameters do not in-
fluence the trajectory generation of an external control system like TwinCAT. Nevertheless, the parame-
ters need to be set to reasonable values as the internal path planner is used for testing of the controller
loop and also for some moves commanded by the external control system (e.g. homing moves). More-
over the setup of the modulo values need to be in accordance with the setup of the external control
system (e.g. TwinCAT).

= ModuloPositionMaximum and ModuloPositionMinimum: If the axis does not require a modulo mo-
tion, which is the normal case if an axis is not a spindle, both values are set to zero. Modulo motion
is typically required for spindles with long running velocity moves and without a restriction of the
move range. For example a typical setting for the modulo range with position unit in radian is:
* ModuloPositionMaximum = 6.283185307179586476925286766559 (= 2m)

+ ModuloPositionMinimum = 0.0

The dynamic settings of the path planner depends on the mechanical and electrical properties of the
axis and on the requirements of the process. The following inequations may help to estimate reason-
able upper limits for the settings:
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umax># rmax+.;<_Ramax+Kvaax
t t
imax>70max+%
t t
Maximal velocity Vmex  [rad/s] Inductance of the motor L [H]
Maximal acceleration  amex  [rad/s?] Inertia of the rotor J (kg m?]
Maximal jerk rmax  [rad/s’] Induced voltage constant K, [Vs/rad]
Maximal current imax  [A] Moment-current constant  K; [Nm/A]
Maximal voltage Umax  [V] External torque Te  [NmM]
Resistance of the motor R [Q]

For DC motors the maximal voltage is given by the DC bus voltage and for AC motors by the DC bus volt-
age divided by square root of three. The inequations above are simplified.

= PositionMaximum and PositionMinimum: Set soft limits for the stroke of the axis. If the axis does
not require soft limits, both values are set to zero. Values other than zero enable the following be-
havior.
+ If a move command such as MoveAbsolute targets a position outside the limits, the move is re-
jected with an error message.
+ If the axis is in coupled motion and the control system runs out of limit, the axis will throw an er-
ror at the soft limit position and trigger an emergency stop.
+ If the axis already is outside the limits, only move commands towards the legal side are allowed.
The same applies to coupled motion, with the following restrictions.
* If the position is higher than PositionMaximum, the velocity must be negative®.
* If the position is smaller than PositionMinimum, the velocity must be positive®.
+ The software limits are only active, if homing is done!
= VelocityMaximum: This parameter specifies the max allowed velocity. The following aspects need to
be considered to set this parameter:
+ design specifications e.g. max required processing speed
+ electrical and mechanical properties of the axis (see also equation above)
max allowed encoder speed (see encoder data sheet)
cut-off frequency of the encoder input (see drive hardware manual)
available DC bus voltage
= AccelerationMaximum, DecelerationMaximum: This parameters restrict the acceleration and decel-
eration during the move. In most cases the same values are used for both parameters. Acceleration
and deceleration are basically restricted by the max available current (see equation above). But also
the following factors need to be considered:
+ static load (e.g. vertical axis)
+ process forces and friction
+ force restrictions of mechanical elements like spindle drives.
= DecelerationEmergency: This parameter is relevant if an emergency stop is commanded. If its value
is zero, the value of DecelerationMaximum is used for the calculation of the emergency stop.
= JerkMaximum: This parameter defines the maximum slope of the acceleration profile. The max pos-

*

*

*

6 The DirectCoupledMotion state expects valid triplets of Position-Velocity-Acceleration data. In the illegal case where triplets contain
velocity=0, the software limit feature will not work properly.
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sible jerk is basically restricted by the available voltage (see equations above). Furthermore the jerk
limit is also relevant regarding how much the mechanical system is excited. A smaller jerk reduces
the bandwidth of the excitement and will therefore also reduce the position error during the move.
Typically the value of the jerk limit is set by factor 10 to 100 bigger than the acceleration maximum.

= JerkEmergency: This parameter is relevant if an emergency stop is commanded. If its value is zero,
the value of JerkMaximum is used for the calculation of the emergency stop.

= DynamicReductionFactor: The dynamic reduction factor fuy is a value in the range [0..1] and can be
use to reduce the path dynamics. The factor scales the limits accordingly the following rules:

— . — 2, _ 3
Vred =V max fdrfl Ored = max fdrf ’ I red =1 max fdrf

5.2.4 Axes[].Parameters.PositionController

The position controller node contains registers to configure the encoder, the position controller and the
feed forward. For a normal axis only Encoder[0] and Controller[0] needs to be configured. Encoder[1]
and Controller[1] are used if an axis provides a second encoder, e.g. for dual loop-control.

= PositionUnit: This parameter is used to define the unit of the positions and it ensures that position
units in TAM System Explorer are displayed correctly.
With EtherCAT this parameter is also used to set the scaling of the set-points received from the con-
trol system. See [2] for more information.
= MasterPositionSource: With this parameters the source for Signal.PositionController.MasterPosition
can be defined.
The following parameters can be used to configure the feed forward. Figure 54 shows the diagram of
the feed forward block.

= FeedForwardPosition: This parameter compensates a force which is proportional to the position,
e.g. a spring. For an initial setup this parameter is set to zero in most cases.

= FeedForwardVelocity: This parameter compensates a viscous friction. As the viscous friction is not
known in advance, this parameter is set to zero for the initial setup.

= FeedForwardAcceleration: This parameter compensates the inertia of the axis. This is an important
parameter regarding the dynamic performance of the axis. Basically, if the inertia of the axis and the
torque constant of the motor are known, the parameter can be set to:

Inertia
TorqueConstant

FeedForwardAcceleration=

But in general it is recommended to set this parameter to zero for the initial setup. The parameter
can then be set and optimized later based on measurements as described in section 5.4.10.

= FeedForwardCoulombCurrent: This parameter compensates Coulomb friction. Initially this parame-
ter should be set to zero. If required, the parameter can then be set later based on measurements.
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Figure 42: Coulomb feed forward.

= FeedForwardCoulombVelocity: With this parameter the transition range of the coulomb feed for-
ward can be set. This allows to smooth the transition of the current when the direction of the
movement is changed.

= FeedForwardFilter: By default the Type of the filter should be set to bypassed.

= QutputLimit: This parameter restricts the output of the position controller. Typically this parameter
is about 5-10% below the peak current of the motor or the drive, depending on which is smaller.

5.2.5 Axes[].Parameters.PositionController.Encoders

The encoder node contains registers to configure Encoder[0] and Encoder[1]. For an axis with only a sin-
gle encoder only Encoder[0] has to be configured. Encoder[1] is used, if an axis provides a second en-
coder signal, e.g. for dual loop-control.

= Type: This parameter is set to the encoder type connected to the related connector. By default this
is connector X20 for Axes[0] and X21 for Axes[1]. Set Type to Analog if the position information is
provided by a pair of analog sine and cosine signals with an amplitude of 1Vpp. See [7] for informa-
tion about other supported encoder types. If no encoder is attached to the connector, the parame-
ter has to be set to None to avoid an EncoderError.

» |nvertDirection: This parameter is used to define the positive direction of the position. Set this pa-
rameter to True, if the positive direction of the encoder position is opposite to the positive direction
of the physical axis. In case this parameter is changed on an already commissioned axis, change the
parameter Motor.InvertDirection too.

= Pitch: This parameter defines the scale of the position. If Type is Analog or Incremental, the value of
Pitch is the distance between two encoder lines. Examples:

+ For a rotational encoder with 2048 lines and with the position unit in degree, the Pitch is 360°/
2048 = 0.17578125°.

* For a linear encoder the value for Pitch is taken from the data sheet of the encoder, e.g. 0.02mm
for an encoder with a pitch of 20um and position units of "mm".

+ If an encoder with digital protocol is used refer to [7] on how to set the Pitch parameter.
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Figure 43: The pitch is displayed for incremental encoders (left) and analog encoders (right). The encoder pitch

corresponds to the distance between the encoder lines or to one signal period.

= VelocityFilterT1: With this parameter the bandwidth of PositionController.Encoders[].Velocity can be

defined. The value corresponds to the time constant of the filter.

Backlash compensation can be applied if an axis shows a directional contouring error during slow mo-
tion. This can for example be caused by the backlash of a spindle drive.

— <

Backlash Backlash
— - — g

Figure 44: Backlash compensation.

BacklashDistance: The value of BacklashDistance has to be set equal to the value of the contouring
error. For dual-loop axes, the backlash has to be configured for the encoder of the inner controller
loop (Encoder[0] in most cases). To align the backlash compensation with the axis reference, the di-
rection of the reference move can be considered for the compensation by setting the sign of the pa-
rameter:
+ Use a positive sign, if the reference move is done in positive direction. In this case the correction
is applied when the axis is moving in negative direction.
+ Use a negative sign, if the reference move is done in negative direction. In this case the correc-
tion is applied when the axis is moving in positive direction.
BacklashDuration: The value of Parameters.PositionController.Encoders[].BacklashDuration can be
used to configure the smoothing of the backlash compensation. If backlash compensation is ap-
plied, a change of direction causes a position shift of the actual position. To smoothing this shift, a
second order low pass filter is applied. The dynamics of this filter can be configured with the param-
eter BacklashDuration. Typical values are in range of 0.1 to 0.5s.
+ A small value causes a fast shift of the position.
+ A big value causes a slow shift of the position.
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Note Backlash Compensation is suitable to compensate contouring errors during slow motion. For
high dynamic moves the application of backlash compensation can be counterproductive as
the backlash error not only depends on the move direction but also on the acceleration and
deceleration.

5.2.6 Axes[].Parameters.PositionController.Controllers

The controller node contains registers to configure Controller[0] and Controller[1]. The structure of the
controller is described in section 5.4. For an axis with a single encoder only Controller[0] has to be con-
figured. Controller[1] is only used if an axis provides a second encoder signal e.g. for dual loop-control.

= Kp, Ki, Kd, T1: These registers are used to configure the PIDT1 position controller. For the initial con-
figuration, these values can be set to zero. The setup and optimization of the position controller is
described in section 5.4.5.

= PositionErrorLimit: This parameter defines the maximum allowed position error (position lag). If the
position error exceeds this limit, the axis is disabled and a PositionErrorLimit error is issued. This is
an important parameter which helps to protect the machine in case of a malfunction. Set this pa-
rameter as small as possible without causing faulty activation of the error. Typical values are 0.1mm
to 0.5 mm for linear axes and 0.1 degree to 1.0 degree for rotational axes.

= PositionErrorWarning: This parameter can be used to rise a warning if a certain position error is ex-
ceeded. The warning level is defined by a factor 0...1 relative to the value of register PositionError. If
the factor is 1, the warning is disabled.

® |ntegratorOutputLimit: This parameter restricts the current of the integral term. It is recommended
to set this value to about 40% to 80% of the nominal current.

= Filters: Filters can be used to optimize the stability of the controller loop. See section 5.4.9 for more
information. For the initial setup the Type of the filters should be set to bypassed.

Warning PositionErrorLimit must be configured correctly before the drive is enabled the first time
to protect the axis.

5.2.7 Axes[].Parameters.Commutation

Commutation is the process of applying current to the phases in the right order to generate motion. For
brushed DC-Motors, commutation is ensured mechanically by contacting the correct winding with the
brush. For synchronous AC motors, commutation has to be performed electronically, in most cases
based on the encoder position.

For electronic commutation it is crucial to initially determine the orientation between the electrical
phases (stator) and the magnetic poles (rotor). The process to find this orientation is called phasing.
With the following parameters, the phasing process can be configured:

= PhasingMethod: This parameter selects the phasing method with the following choices (see also
Figure 45):
+ NoPhasing: This method is used if Axes[].Motor.Type = DC or if a motor with an absolute encoder
is already initialized with the correct phasing angle (see also section 6.1 in case the commutation
information of an absolute encoder should be used).

+ RotorAlignment: The rotor is aligned by applying a current to a specific phase angle. This causes
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the rotor to align with the magnetic field of the phases. If the rotor is not already aligned by
chance, this causes a movement of the rotor. This method must be used for the initial phasing
during commissioning of synchronous AC-motors as it does not require a tuned position con-
troller.

AngleSearch: With this method, the electrical direction of the current is controlled in such a way,
that the motor does not move during angle search. This method requires a stable setup of the
position controller. It is recommended to use this method for axes which must not move during
phasing. As AngleSearch requires a tuned position controller it is not suitable for the initial
setup.

Pca=0

Figure 45: Phasing Method: a) Before phasing the commutation angle is unknown. b) RotorAlignment:
The rotor is aligned with a static electromagnetic field generated by the phase currents. c) AngleSearch:
The angle of the electromagnetic field is adjusted to match with the magnetic field of the rotor without
moving it.

AngleSearch2: This method is an improved version of the AngleSearch method that allows the
motor to be in motion when the phasing algorithm starts. It is recommended to use this method
for axes with low damping (e.g. axes with air bearings). From the start of the procedure until
RampRiseTime is reached, the velocity of the axis is kept constant. Then, the axis is decelerated
to zero velocity by the time half of the RampConstTime is reached. All this happens simultane-
ously while the algorithm determines the phasing angle. As this method uses velocity estima-
tion, the VelocityFilterT1 of the master encoder must be configured to an appropriate value, es-
pecially when using serial encoders. Also, AngleSearch?2 requires a tuned position controller and
is not suitable for an initial setup.

The method AngleSearch?2 is available with firmware version >= 4.24.0 and TAM System
Explorer version >= 7.28.2.

= EnablingMethod: This parameter specifies if phasing is executed when the motor is enabled. In case
of an absolute encoder the parameter is used to specify the source for the commutation offset. The
following options can be selected:

*

*

ForcePhasing: Phasing is executed at every enabling of the motor.

Automatic: Phasing is executed only if Axes[].Signals.Commutation.State is Invalid. This could for
example be the case after a power-cycle of the drive. The commutation state will change to Valid
when phasing is executed successfully. This method should not be used before the commission-
ing of the current controller and the position controller is successfully done.

NoPhasing: This option is used if Axes[].Motor.Type = DC.

AbsoluteEncoder; AbsoluteEncoderOffsetEncoder; AbsoluteEncoderOffsetDrive: See section 6.1
for how to setup the commutation based on absolute encoders.
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For an initial setup it is recommended to use ForcePhasing. Depending on the application the set-
ting can be changed for example to Automatic after the commissioning is successfully done.
During phasing, a current is applied. The shape of this current can be configured with the following
parameters (see also Figure 46).

= Angle: This is the electrical angle of the phasing vector used in the RotorAlignment method. Default
value is zero.

= StartTime: This parameter delays the start of the phasing. During this period, the voltage controller
of the drive is already active and causes damping of the motor because of the back electromotive
force. A StartTime greater than zero might be useful in the following cases:

* In case a brake with significant delay has to be released before the phasing starts.

* In case the phasing fails because of ongoing movements of the axis. Increasing the StartTime re-
duces the motion of the axis. This is a typical use case for axes with low friction e.g. axes with
air-bearingins.

= RampRiseTime: This parameter is used to configure the duration of the current ramp. The recom-
mended setting for this parameter depends on the PhasingMethod:

* RotorAlignment: RampRiseTime typically 1.0-2.0s

+ AngleSearch and AngleSearch2: RampRiseTime typically 0.1-0.2s

= RampConstTime: This parameter should be set to a value which allows the axis to reach steady
state. Depending on the type of axis this is typically 0.5-2.0s. The value has to be increased, if the
axis is still in motion at the end of the phasing.

= Current Amplitude: This parameter defines the amplitude of the applied current. It is typically set to
50-100% of the nominal current.

It is possible that the initial position of the axis is exactly opposite to the applied current-angle. In this
case nearly no torque is applied to the motor and phasing may fail. To prevent this case, the angle of
the applied current is oscillated three times at the beginning of the phasing. This should get the axis out
of its equilibrium. The following parameters can be used to configure the oscillation.

= SineAmplitude: Amplitude of the angular oscillation of the commutation angle. Typical values are
0.1-0.5rad.

= SineFrequency: Frequency of the angular oscillation of the commutation angle. Typical value is
10Hz. Ensure that: 3/SineFrequency<0.8:-( RampRiseTime+ RampConstTime) .
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Figure 46: Phasing sequence with Type = RotorAlignment.

5.2.8 Axes[].Parameters.CurrentController

This section describes the initial setup of the current controller. The structure of the controller is de-
scribed in section 5.4.

PwmFrequency: This parameter is used to define the frequency of the pulse width modulation. In
most cases this parameter should be set to pwm50kHz, as this allows higher drive currents. Only for
motors with very low impedance (e.g. spindles) pwm100kHz can be considered to reduce the heat-
ing of the motor.
Kr, Tn: These registers are used to configure the Pl current controller. For initial configuration these
values can be set to zero. The setup and optimization of the current controller is described in sec-
tion 5.4.1.
IntegratorOutputLimit: This parameter can be used to restrict the output of the integral term to
avoid a windup behavior of the controller. Typically this value is set to 0.5..1.0 of the CurrentCon-
troller.OutputLimit (see below)
R, L, Kt: These are the voltage feed forward parameters with R representing the stator resistance
(half of phase to phase resistance), L representing the stator inductance (half of the phase to phase
inductance) and Kt representing the voltage constant of the motor.
Remark: These parameters are also required for sensorless mode [8], in most other cases it is rec-
ommended to set these parameters to zero as voltage feed forward is not required due to the high
bandwidth of the current controller.
FeedForwardLimit: Set this parameter to limit the feed forward voltage calculated by the R, L and Kt
parameters. If FeedForwardLimit is set to zero, the feed forward path is disabled.
OutputLimit: This parameter restricts the maximum output voltage over one phase. Typically this
parameter is set to the maximum possible voltage which depends on the available DC-bus voltage
and the MotorType:

+ SynchronousAC: The maximum setting is 0.577 times the dc-bus voltage.

+ DC: In case of a DC-motor the OutputLimit can be set equal to the DC-bus voltage.
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= Filter: The filter can be used to shape the output of the controller loop. See section 5.4.9 for more
information. For the initial setup the Type of the filters should be set to bypassed.

5.2.9 Axes[].Parameters.CurrentController.FieldWeakening

Field weakening is a method for increasing the speed of electrical motors if the DC bus voltage is the re-
stricting factor. This is accompanied by a reduction of the maximum torque of the motor. Field weaken-
ing with synchronous AC motors and Field Oriented Control is achieved by inducing a negative i, current
depending on the speed of the motor. It is mainly applied to high speed spindles, if the desired speed is
not reached.

= VelocityStart: This parameter determines the velocity above which the field weakening is applied.

= Gain: With the Gain the induced current ips, is calculated depending on the velocity according to the
following equation. To induce a negative ips the Gain has to be smaller than zero. Set the Gain to
zero to disable the field weakening.

P Gain-(|velocity|— VelocityStart )  if |velocity|> VelocityStart
bfw 0 else

5.2.10 Axes[].Parameters.CurrentController.FeedForwardFilter

By default and for a first setup the Type of the filter should be set to bypassed to deactivate it. Refer to
Figure 49 for more information.

5.2.11 Axes[].Parameters.Homing

This node can be used to configure a homing sequence executed by the drive. More information about
how to setup the homing of an axis is documented in [10].

= Method: For the initial setup of the axis no homing is required and the homing method is set to
None.

5.3 Verification of the Encoder

With this test the configured encoder pitch and the encoder direction are verified. For the test, move
the axis by hand for a certain distance e.g. for one turn and observe the position in the TAM System Ex-
plorer. To observe the position the following options are available.

1. Select the associated axis module in the Topology Tree and observe the position displayed at the
upper right corner of the axis module (see Pos 5 in Figure 31).

2. Observe the value of the register Axes|].Signals.PositionController.Encoders[].Position in the Regis-
ters tab of the Tab Panel.

3. Drag the register Axes[].Signals.PositionController.Encoders[].Position into the Scope Area and
start the scope.

Check the counting direction and if the relative distance of the displayed position corresponds to the
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executed move. If there is a mismatch, adjust the following parameters and execute the test again.

= Axes[].Parameters.PositionController.Encoders[].InvertDirection
= Axes[].Parameters.PositionController.Encoders|].Pitch

In case the position signal shows no movement at all, the connection of the encoder has to be verified.
Especially if an option module is used also check the setting of General.Parameters.EncoderTopology
(see [7] for more information).

5.4 Controller Tuning

After initial configuration of the parameters, the controllers are ready to be tuned. For the tuning of the
controllers the Frequency Response module provided by TAM System Explorer is used (see chapter 4).
The following sections show the structure of the controller and explain how to execute the Frequency
Response Tuning. For people with experience in Triamec drive configuration, Figure 72 can lead you
through the tuning procedure.

Figure 47 shows a simplified block-diagram of the implemented controller structure. The controller
structure supports cascaded control with a Pl controller for the current and two PIDT1 controllers for
the position.

For an axis with one encoder, only Controller[0] is used. If a second encoder is installed, use
Controller[1] to setup a dual loop controller. Both, the position controller and the current controller
support feed forward to set the current and the voltage based on the setpoint trajectory.

ServoDrive-SetupGuide_EP030 2025-05-02 57/s6



Drive Configuration
,) fig

] Controller Tuning
triamec

PositionController CurrentController

Pathinterpofator.Velocity I PathinterpofatorVelocity
0 -

Pathinterpolator.Acceleration FeedForwardCyrrentDerivative

[

FeedForward FeedForward
O—p :
} . Current ’Q > Voltage
Pathinterpolator.Position FeedForwardCurrent
i ! ’Q >
Desired Desired

VoltageQ

CurrentQ
‘ Current >0
Encoder([0]. F’?_’ o] "é“ ’?_b Controller :
POS('E“C’“ Output Limit Output Limit |

Controller[1]

Encoder[l].
Position

" H ActualCurrentQ
S o S |

Figure 47: Block-diagram of the controller structure with current controller and position controller (simplified).

5.4.1 Current Controller Structure

The controller structure consists of a Pl-controller with proportional gain Kr and integral time constant
Tn. Additionally, the integral term can be restricted to prevent integral wind-up. At the output a filter of
second order can be configured.

o >|K W2 s2+2D,W,s+w’
e & o o nel 0
$°+ 2D ;W s+Wwy
CurrentError h P
1 OutputVoltage
—
S
Integral Integrator
OutputLimit

Figure 48: Block-diagram of the PI current controller (simplified).

In some cases the dynamic of the current loop can be improved by applying voltage feed forward. Fig-
ure 49 shows the block-diagram for voltage feed forward.
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Figure 49: Block-diagram of the voltage feed forward.

2 Tuning of the Current Controller

This section describes how the proportional gain Kr and the integral time constant Tn for the current
controller can be determined with Frequency Response Tuning. See section 5.2 on how to initially set up

the other parameters in the current controller structure. The following steps are required to start the
tuning:
1. Make sure, that the controller gain Kr is set to 0 (this step is not required if the current controller
is already configured with a stable setting).
2. Execute a Frequency Response measurement and save the measured data. See section 4.2.1 on
how to do the measurement.
3. Open the measured data with the Frequency Response Tuning application. See section 4.2.2 on
how to open the measurement and how to use the application.
4. To setup the current controller, select the Current radio button in the Select Controller panel.
5. Initially, set the controller gain Kr to 1 (if Kr is zero, no transfer functions are plotted).
6. Start the tuning based on the criteria below. Consider also the “rule of thump” (see section 5.4.3)
or use the Estimate Controller button (see section 5.4.4).
The controller parameters Kr and Tn can now be modified. After each change of a parameter the Bode

or Nyquist plots are updated. The Bode plot shows the amplitude and the phase of the following com-
plex transfer functions:

Hf)=e (15 )i =R ) s=j2n f

with

= f: frequency

H,(f): current controller transfer function

H,(f): open loop transfer function

H.(f): closed loop transfer function

i/u(f): measured frequency response function between voltage and current.

The Nyquist plot shows the open loop transfer function H,(f) in the complex area.

The goal for the tuning is to get a stable controller with the following characteristics (see also Figure 50
and Figure 51):
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a) wide bandwidth of H(f)
b) high amplification in the pass-band of H,(f)
c) sufficient attenuation in the stop-band of H,(f)

Therefore, Kr should be increased while Tn is reduced as close to zero as possible by considering the fol-
lowing criteria. See Figure 61 on how the parameters influence the curve.

Tuning criteria in Bode plot view:

d) The phase-margin of H.(f) should be in range of 50° to 70°.”
e) The amplitude of the H.(f) should not exceed 1dB over the whole frequency range.

G -01dB;-1229° pBode Diagram @ Bode Nyquist

abs(G) [dB]

1 i 1
99.984 1000 10030

gle(G) [grad]

"

-180—

'2707 | !
99.984 1000 10030

Figure 50: Tuning criteria in Bode view for the current controller.

Tuning criteria in Nyquist plot view (Figure 51):

f) The displayed complex curve of H,(f) must be outside of the 1.1 circle but as close to it as possi-
ble.

g) Following the complex curve H,(f) from low frequency to high frequency, the critical point [-1,
0j] must be located in the region to the left of the curve.

7 The phase-margin is the difference between the phase-angle of a transfer function G,(f,) at the frequency f,c where the amplitude of
Ho(fqc) crosses 0dB and -180°. See d) in Figure 50.
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369 H: G: -0.1 dB: -122.9° Nyquist Plot Bode @ Nyquist

Imag(Gopen) [-]
4=

Figure 51: Tuning criteria in Nyquist view for the current controller.

5.4.3 Rule of Thumb for Current Controller Tuning

This section describes a rule of thumb for an initial setup of the current controller. See also the Esti-
mate Controller section 5.4.4.

1. Set Kr=1and Tn =0, and activate the Bode plot view.

2. With the cross-hair search the frequency f,c where H,(f;) has a phase margin of 60° (Figure 50,
marker d)).

3. Read the amplitude A, at frequency f,.in dB.

4. An initial value for the gain and the time constant can now be calculated with the following equa-
tions (see also Figure 52):
A
kr=10 *° Tn:%
gc
5. Use the criteria above to further optimize the current controller.
6. Press the Commit button to activate the parameter changes on the drive.

5.4.4 ‘Estimate Controller’-Button (Current Controller)

The Estimate Controller button can be used to apply an initial tuning of the current controller. The ap-
plied tuning is based on the rule of thumb described in section 5.4.3. Follow the following steps to use
the Estimate Controller button for an initial tuning:

1. In the Bode View place the cross hair at the frequency f,c where the angle of the open loop trans-
fer function H,(f,) (red line) has the desired phase margin e.g. 60° (see Figure 50, marker d)).
2. Press the Estimate Controller button. With this, an initial controller setting is calculated.
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3. Use the criteria in section 5.4.2 to further optimize the current controller.
4. Press the Commit button to activate the parameter changes on the drive.

268 -1204°  Bode Diagram ©® Bode MNyquist  Frequency: 1880H: & -01dB-1196°  Bode Disgram ® Bode Nyquist

absi) [dB]

abs(6) [dB]

I
20 100 1000 10000 24000

angle(G) [grad]
angla(G) [grad]

=360~

=540,

| -540—

i i i i i I
20 100 1000 10000 24000 20 100 1000 10000 24000

Figure 52: Tuning of the current controller. The figure to the left shows the bode plot with Kr = 1 and Tn=0 a phase
margin of 60° (angle = -120°) is reached at 2188Hz with a magnitude of -28.6dB. Based on the rule of thumb this
would result in Kr = 27 and Tn = 0.0007. The figure to the right shows the further optimized transfer function with
Kr=23 and Tn=0.0001.

5.4.5 Position Controller Structure

Figure 53 shows the controller structure of the position controller. It consists of a PIDT1-controller with
proportional gain Kp, integral gain Ki and derivative gain Kd. The bandwidth of the derivative term can
be restricted with the low pass time constant T1. With the IntegratorOutputLimit wind-up of the inte-
gral can be avoided. Additionally five second order filters can be configured.

s
Kd
T1s+1
Differentiator
KD with Lowpass -~ 1 g, on gent

PositionError wi s+ 2D 0,5+ w5 Output

> 1 5 x Filter
Ki B
5

Integral  Integrator
OutputLimit

Figure 53: Block-diagram of the PIDT1 position controller.

Figure 57 shows the block diagram for current feed forward. Beside the feed forward of position, veloc-
ity and acceleration also coulomb friction can be compensated. The FeedForwardFilter can be used to
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fine tune the feed-forward transfer function.

Acceleration

FeedForward
Acceleration

Posw%on

FeedForward
Position

FeedForward
du Derivative
» — —»0

dt

Differentiator
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= L

ufi 52+2deds+m§ o

lEF
-

A

Ve\g?dty

FeedForward
Velocity

FeedForwardFilter

-
-

FeedForwardCoulombCurrent
FeedForwardCoulombVelocity

Figure 54: Block-diagram of the current feed forward.

5.4.6 Tuning of a Single-Loop Position Controller

Important The current controller (inner loop) has to be setup before the position controller (outer
loop). This is because the parameterization of the current controller influences the
characteristics of the position controller. The current controller in contrast is indepen-
dent of the parameterization of the position controller.

This section describes the tuning of a single loop position controller®. With single-loop setup, only one
position feedback is used for control.

= |f the loaded Frequency Response measurement contains only one encoder signal, this signal is au-

tomatically used for the tuning. The radio button Position 1 is grayed out and Single Loop is set per-
manently.

= |f the loaded Frequency Response measurement contains signals from two encoders, Single Loop is

set by default and should only be changed for dual-loop control. The signal used for the tuning can
be selected as follows:

+ With Position 0 latched, the signal from Encoder[0] is used.
+ With Position 1 latched, the signal from Encoder[1] is used.

This section considers only the first case, as this is the default case for single-loop position controllers.
Important  For synchronous AC motors the measurement of the transfer function between current
and position requires a valid commutation. If the commutation angle is not provided by

an absolute encoder, the initial (first time) commissioning of the position controller re-
quires to set

Parameters.Commutation.PhasingMethod to RotorAlignment and
Parameters.Commutation.EnablingMethod must not be Automatic!

Important The Frequency Response measurement has to be executed again after the first
commissioning of the current controller (see also 4.2.1.4)!

To setup the position controller, Position 0 has to be selected in the Select Controller panel. The Con-

8 For other typologies see application note [9] for dual loop axes and [11] for gantry axes.
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troller Parameter panel shows the parameters used to configure the PIDT1 controller.

Two equivalent controller structures can be selected in the Select Controller Structure panel. This se-
lection has no effect on the behavior of the controller as all structures are internally transformed to the
Additive, Gain structure, but it allows to select the structure which is most suitable for the tuning.

= Additive, Gain:
Figure 55 shows the parameters used to configure the PIDT1 controller if Additive, Gain is selected.
With this structure, the parameters are identical with the controller registers in the Topology Tree.
The controller output is the sum of the integral path weighted with Ki, the proportional path

weighted with Kp, and differential path weighted with Kd and filtered with a low pass filter with
time constant T1 (see also Figure 56).

Select Controller Structure

() Additive, Time Constant
Additive. Gain

Control Parameters

Kp [A/°]:
Ki 1A/l
Kd [A*s/7: 0.00125]

Figure 55: Controller Parameter with Additive, Gain selected.

s
Kd _
Tis+1
Differentiator
P with Lowpass _ Wi sH2D 005+
Ll —_—
PositionError wl s+ 2D, 0y s+ W] Output
> 1 5 X Filter
Ki = >
S

Integral Integrator
OutputLimit

Figure 56: Additive, Gain controller - the parameterization of this structure corresponds to the controller registers in
the Topology Tree.

= Additive, Time Constant:

Figure 57 shows the parameters used to configure the PIDT1 controller if Additive, Time Constant is
selected. In this case the integral and derivative terms are weighted by the time constants Tn and Tv
and the position error is multiplied by Kr (see also Figure 58).
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Select Controller Structure

Additive. Time Constant

() Additive, Gain

Control Parameters

Translated:

Kr [A/°]: 0.5 Kp [A/F] 0

Tn [s]: 0.00749899937| Ki [A/°/s]: 66.66667

Tv [s]: 0.0025| Kd [A*s/°]: 0.00125

il
il

T1 [s]: 0.00025| T1 [s]: 0.00025

Figure 57: Controller parameters with Additive, Time Constant selected

S
TIs+1
Differentiator
p with Lowpass w3 s2+2D, w5+l
PositionError Wi 5%+ 2D 0y 5w Output
l - 5 x Filter
s
Integral  Integrator
OutputLimit

Figure 58: Additive, Time Constant structure - the parameters are directly transformed to the gain-structure as used
in the Topology Tree.

The following table shows the equations of the two structures and how Additive, Time Constant is
transformed to Additive, Gain:

Additive, Gain Additive, Time Constant
_ S 1 Tvs 1
Gr(S)—KdT1$+1 +KP+K’ s Gr(5>—Kr TT1s+1 +1+Tn5)
._Kr _ )
Kp=Kr K/—ﬁ, Kd=KrTv;
Note In most cases it is recommended and more intuitive to use Additive, Time Constant for the

tuning of the position controller.

With the Select Filter panel up to 5 filters can be configured. Use the Filter Parameters panel to set the
Type, frequency f[Hz] and damping D[1]. To disable the filter, the type is set to Bypass. If Advanced is
checked, the frequency and damping of the numerator and denominator can be set independent (see
also chapter 5.4.9).

The Bode plots show the following complex transfer functions:

X
1

G, (f);  Golf)=G(fIHf)F(FIFo(FIFs(f) . Falf); G.(f)

with
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f: frequency

G/{f): position controller transfer function

G.(f): open loop transfer function

G.(f): closed loop transfer function

H.(f): closed loop current controller transfer function
x/i(f): measured frequency response current to position
Fo(f)Fi(f)...Fa(f): filter transfer function

The Nyquist plot shows the open loop transfer function G,(f) in the complex area.

The goal for the tuning of the position controller is to get a stable controller with the following charac-
teristics (Figure 59 and Figure 60):

a) wide bandwidth of G(f)
b) high amplification in the pass-band of G,(f)
c) sufficient attenuation in the stop-band of G,(f) (which may require to place some filters).

with the following tuning criteria in Bode plot view:

d) The phase-margin of G,(f) should be in range of 30° to 50°.
e) The amplitude of the G.(f) should not exceed 2dB (robust) to 4 dB (advanced) for a stable con-
troller behavior over the whole frequency range.

G 14dB-1318° pode Diagram @ Bode Nyquist

abs(G) [dB]

I I
20 100 1000 99484

-180

angle(G) [grad]

-360 i i
20 100 1000 99484

Figure 59: Tuning criteria in Bode view for the position
controller.

Tuning criteria in Nyquist plot view:

f) The displayed complex curve of G,(f) must be outside of the 1.3 (robust) to 1.6 (advanced) circle
but as close to it as possible.

g) Following the complex curve G,(f) from low frequency to high frequency, the critical point [-1,
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0j] must be located in the region on the left of the curve.

G: 1.9 dB;: -132.5" st Plot Bode @ Nyquist

Imag(Gopen) [-]

Figure 60: Tuning criteria in Nyquist view for the position
controller.

5.4.7 Rule of Thumb for the Tuning of the Position Controllers

This section describes a rule of thumb for an initial setup of the position controller. See also the Esti-
mate Controller section 5.4.8.

1. Set Kr =1 and Tn = 0, activate the Bode plot view and Additive, Time Constant in the Select Con-
troller Structure panel.

2. Choose an initial value for the gain crossover frequency f,.°. For a high performance axis with ana-
log encoder, f,cis typically in the range of 300Hz to 600Hz. For less stiff axes or encoders with low
resolution, f, may be reduced to below 100Hz to meet the stability criteria. A good starting point
is often 200Hz which can be adjusted later iterative.

3. Based on the selected f,, initial values for the parameters Tvand T1 can be calculated:

1 1

T2 e 20fge
The angle plot should now show a sufficient phase margin’ at f,. of more than 30° to 50°. If this is
not the case, the gain crossover frequency f,. may have to be reduced.

4. Measure the amplitude A, at frequency f,c in dB in the bode plot with the crosshair. An initial
value for the gain Kr can now be calculated based on the measurement:

—_— Agc
20

Tv T1=

Kr=10
The magnitude of G,should now cross the 0dB level at the frequency f,..
5. Check the stability of the controller in the Bode and the Nyquist plot based on the criteria listed

9 The gain crossover frequency f, is the frequency at which the gain of the tuned controller (open loop) crosses 0dB.
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above. If the stability of the controller is insufficient reduce f,cor try to apply filters to compensate
unstable resonances.
If the stability is sufficient, the integral time constant can be set by using the following equation
as an initial value.

Tn=E

fgc

Use the criteria above to further optimize the position controller. Figure 61 shows a tuned con-
troller and indicates qualitatively the effect of the parameter changes on G,(f) in the Bode and
Nyquits plot.

8. Press the Commit button to activate the parameter changes on the drive.

abs(G) [dB]
o
=
1

G 14dB;-13183°  Bode Diagram ® Bode Myquist  Freque 507.2 Hz G -03dB; -140.2° Nyquist Plot Bode ® Nyquist

Imag(Gopen) [-]

-1.5+

i I ' ' ' l ' ' ' i
100 1000 00484 -3 -2.5 =2 =15 -1 -0.5

Figure 61: Tuned position controller with a gain crossover frequency f,. of 420Hz and a phase margin of 48.2°. The

5.4.8

black arrows indicate the effect of parameter changes in Bode and Nyquist plot (qualitatively).

‘Estimate Controller’-Button (Position Controller)

The Estimate Controller button can be used to apply an initial tuning of the position controller. The ap-
plied tuning is based on the rule of thumb described in section 5.4.7. Follow the following steps to use
the Estimate Controller button for an initial tuning:

1. In the Bode View place the cross hair at the desired gain crossover frequency f,. (see section
5.4.7. for more information about f).
2. Press the Estimate Controller button. With this, an initial controller setting is calculated.
3. Use the criteria in section 5.4.6 to further optimize the position controller.
4. Press the Commit button to activate the parameter changes on the drive.
Note The Estimate Controller algorithm is applicable for common axes. Depending on the

properties of the axis the quality of the resulting tuning can vary and in some cases the
algorithm might not be applicable.
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5.4.9 Filters

Filters can be used to enhance the properties of the controller loop for example by compensating me-
chanical resonances. Although filters can improve the controller loop, filters should be applied cautious
for the following reasons:

= Controller loops with filters are often more sensitive to changes to the axes.

= Filters increase the complexity of the controller-loop. Therefore a robust setting is more difficult to
find.

= Consider that only resonances which violate the stability criterion (see section 5.4.6) need to be
compensated.

The design of a filter should be done with the Frequency Response tool based on a Frequency Response
measurement. Different filter types can be selected. But in most cases Notch2 is applied and will be de-
scribed below.

Only for position measurement with poor resolution (e.g incremental encoders) Lowpass1 or Lowpass2
are used to smooth the signal. In this case the frequency fd is set 3 to 10 times the bandwidth of the
controller and for Lowpass2 the damping Dd is set to 0.7. Consider that the application of lowpass fil-
ters will reduce the phase-margin and therefore affect the stability of the controller. It is recommended
to verify the stability of the controller with the Frequency Response tool after a filter is modified.

Notch2

The following equation shows the transfer function of the Notch?2 filter:

w5 s°+2D,m, 5+ 0>
Fi<5)_

- 22 2
W, s°+2D, wy5+wy

with the following relation to the configuration parameters:

w, = 2nfd = 2nEdgeFrequencyDenominator
D, = Dd = DampingDenominator

w, = 2mnfn = 2nEdgeFrequencyNumerator
D, Dn = DampingNumerator

The Notch2 filter can be considered as the product of a Lowpass2 defined by fd and Dd and a Highpass2
filter defined by fn and Dn (Figure 62). The Highpass2 parameters fn and Dn define the location and the
sharpness of the notch. The Lowpass2 is used to compensate the strong amplification with higher fre-
guencies caused by the Highpass2. As a simple approach, set the parameters as follows:

fn = Frequency to compensate
Dn = 0.01..0.05

fd = fn

Dd = 10Dn

When Advanced mode is not checked in the Filter Parameters panel, fd and Dd are automatically calcu-
lated according the equations above.
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Bode Diagram
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Figure 62: The Notch2 filter as product of a Lowpass2 with fd=1, Dd= 0.2 and a Highpass2 with fn=1, Dn=0.01.

Consider the phase drop in the phase plot of Figure 62 below the notch frequency. This phase drop may
reduce the phase margin and could reduce the stability of the controller. Therefore, the stability of the
controller has to be checked after a filter is added or modified.

Figure 63 shows a resonance which causes an instability at 2000Hz. In the Nyquist plot, resonances ap-
pear as circles. Figure 64 shows the same transfer function now with a Notch2 filter applied at 2000Hz.
The controller loop is now stable.
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Figure 63: Resonance at 2000Hz which causes an instability of the controller-loop.
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Figure 64: Notch?2 filter with fn = fd = 2000Hz, Dn = 0.01 and Dd= 0.1 compensates the resonance.

5.4.10 Acceleration Feed Forward

A proper setting of the value for FeedForwardAcceleration is very important to achieve small position
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errors during high dynamic movements. The value for FeedForwardAcceleration can also be determined
based on the Frequency Response Measurement:

1. Open the measured data with the Frequency Response Tuning application. See section 4.2.2 on
how to open the measurement and how to use the application.

2. Select Position 0 in the Select Controller panel if single loop controller is used.

3. At lower frequencies the amplitude in the Bode view of Gplant should show a linear section with
a drop of 40dB per frequency decade and a phase angle of -180 dgree. Place the cursor at a fre-
quency f within the linear section (see also Figure 65).

4. Press the Estimate FFA button to evaluate the gain for the acceleration feed forward.
5. Press the Commit button to activate the parameter changes on the drive.

The Estimate FFA algorithm uses the following equation for the calculation with A the magnitude of
Gplant at the selected frequency f.

. 1
FeedForwardAcceleration=—;
20 2
10" (2n f)
Select Controller Frequency: 1012 Hze G -B6.2 dB; -180.9° © Bode (O Myquist

() Current © Position 0 @

143

Select Controller Structure

© Additive, Time Constant

() Additive, Gain

Control Parameters E
Translated: =

Kr [Afu]: 200000 Kp [A/u]: 200000 =

Tn [s]: 0,005 Ki[Afu/s]: AE+07

T [s]: 0.001  Kd [A*s/ul: 200.000015

T1 [s]: 5E-05 TI1[s]: 5E-03

1
Feed Forward Acceleration [A*s*/u]: 0.0504 |
20 100 1000 10000

Figure 65: Calculation of the acceleration feed forward. With a measured amplitude of -65.3dB at 29.8Hz, the accel-
eration feed forward is set to 0.052.
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5.5 Verification of the Setup

This section describes how to use the Axis Module and the Scope to verify the setup (see also section
3.3and 4.1).

5.5.1 Motor Direction and Magnetic Pitch

To verify the motor direction and the magnetic pitch, the TestGenerator is used to apply a rotating cur-
rent vector, which will move the axis in positive electrical direction. It is recommended to execute this
check if:

= The Frequency Response measurement shows an unexpected characteristic.
= The axis goes in an axis error state immediately after the phasing.
= There is uncertainty if the magnetic pitch is configured correctly.

Preconditions:

= To rotate a current vector, the current controller needs to be configured properly as described in
section 5.4.2.

The following steps are required to run the verification.

= Temporary increase PositionController.Controllers[0].PositionErrorLimit to a value bigger than one
pole-pair pitch (e.g. to 10 times the magnetic pitch).

= Temporary set the gains Kr, Ki, Kd of the position controller to zero to disable the position controller.

Prepare the scope by loading the Scope Configuration named Direction Analysis.

Prepare the TestGenerator with the following values.

* Frequency: This parameter defines how fast the axis will move during the test. For example, if
the parameter is set to 0.5Hz, it will take 2s to move a distance of one pole pair pitch.

Amplitude: 0
Offset: 50% to 100% of the nominal current
¢+ RampTime: 2s

*

*

¢+ CommutationAngle: Orad

Enable the axis, start the scope and set Axes[].Commands.TestGenerator.Command to StartRotat-
ingVectorConstantCurrent and press Enter.

Warning  As soon as StartRotatingVectorConstantCurrent is committed, the axis will start to move.
The value of TestGenerator.Frequency has to be set slow enough to stop the axis in time
(see next item).

= |f the setup is correct, the axis will now move with the defined frequency. To stop the axis, set Test-
Generator.Command to Stop and press Enter. Stop the scope and disable the axis.

= To verify the motor direction, check if the signals of Commutation.Angle and PositionController.En-
coders[0].Position have the same direction (see also Figure 66). If the direction is opposite, switch
the state of the parameter Motor.InvertDirection.

= To verify the magnetic pitch, check if one electrical turn (2-m) on the Commutation.Angle corre-
sponds to the magnetic pitch measured on PositionController.Encoders[0].Position (see Figure 66).

= Do not forget to reset PositionController.Controllers[0].PositionErrorLimit and the position gains Kr,
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Figure 66: Verification of motor direction and magnetic pitch: The motor direction is
correct as the signal of Angle and Position show the same direction. The magnetic pitch
is 24 mm according to the measurement.

5.5.2 Commutation

To verify the commutation of the axis, the axis should be enabled at different positions and it should be
verified if a move can be executed:

1. Check if Parameters.Commutation.PhasingMethod is set as desired and if Parameters.Commuta-
tion.EnablingMethod is not set to Automatic!
2. Prepare the scope by loading the Scope Configuration named Phasing Analysis.
3. Start the scope and enable the axis.
4. Check the scope if the characteristic of the signals is as expected.
+ If Commutation.Commutation.PhasingMethod is RotorAlignment:
* Check if the current ramp of ActualCurrentD is applied as expected.
* Check if the position signal shows an alignment move.
* Axes with low friction (e.g. with air-bearings) could show a slow oscillation during the phasing
which could lead to an invalid commutation. In this case the PhasingMethod should be

changed to AngleSearch2 and the commutation parameters should be adjusted accordingly
(see section 5.2.7).

= |f Commutation.PhasingMethod is AngleSearch or AngleSearch?2:

* Check if the current ramp of ActualCurrentD is applied as expected.

* Check if the position signal shows only a minor motion.

* Check if the position shows no instability and the position error is zero at the end of the phas-
ing. If the error is not zero, try to reduce Parameters.Commutation.RampRiseTime and verify
the stability of the position controller. Consider switching the PhasingMethod back to Ro-
torAlignment to verify the position controller with a new Frequency Response measurement.

* No loud noises should be heard during phasing.
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5. Check if the axis is stable by manually applying torque to the axis if possible.

6. Reduce the Acc. and Vel. values in the Axis Module, start the scope and execute a move of at
least one electrical turn.

7. Repeat this sequence at different positions.

8. If the phasing works as expected, Parameters.Commutation.EnablingMethod can be set to Auto-
matic.

Note If the axis goes into error state immediately after the phasing sequence or at the start of a
move, the parameter MotorlnvertDirection might be incorrect. Also verify Parameters.Mo-
tor.PolePairs and Parameters.Motor.EncoderCountsPerMotorRevolution (see also section
5.5.1).

5.5.3 Position Controller

If the commutation works as expected, the controller setup can be verified in time domain. In the fol-
lowing, two different approaches are described with which a setpoint can be generated:

Test Generator

If registers in node Commands.TestGenerator are configured accordingly, a square wave can be added to
the position setpoint. By measuring the position or the position-error the step answer can be analyzed.
The step size (amplitude) of the test signal has to be small enough, to not exceed the output limits of
current and voltage. Therefore step answer is especially useful to analyze the small signal behavior and
the stability of the controller.

1. Prepare the scope by loading the Scope Configuration named Position Controller Disturbance
Tuning.

2. Increase the value of Parameters.PositionController.Controllers[].PositionErrorLimit temporarily to
not cause an error during the test.

3. Start the scope.

4. Enable the axis for example by using the Axis Module.

5. Prepare the test generator: Frequency: 5Hz, Offset: 0, RampTime: 0. Amplitude: The amplitude
should be set to a small value to not exceed the limits of current or voltage.

6. Start the test signal by setting Commands.TestGenerator to StartPositionSquare.

Axis Module

With the axis module, a move can be executed which is generated by the internal path planner with re-
striction of velocity, acceleration and jerk. Therefore this test is useful to analyze the process related
stability and behavior of the axis and the settings of the feed forward.

1. Prepare the scope by loading the Scope Configuration named Position Controller Follower Tun-
ing.

2. Prepare the Axis Module: Setup a reasonable move between A and B. Activate the Loop After
check-box and set a wait time of about 500ms. Reduce the dynamic by adjusting the Acc. and Vel.
values in the Axis Module.

3. Start the scope and execute moves by pressing Move AB. Check the transient response of the sig-
nals. Slowly increase the dynamic settings.

If the position error shows oscillations of a certain frequency, check the Bode plot for a reason of the
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oscillation (see also Figure 67 and Figure 68). Try to adjust the parameters to increase the damping (in-
crease phase margin) or reduce the amplitude. Consider applying filters to damp the oscillation.

If the position error increases when a certain velocity is reached, the limit for the voltage output might
have been reached (see also OutputLimit of the current controller in 5.2.8).

If the position error increases when a certain acceleration is reached, the limit for the current output
might have been reached (see also OutputLimit of the position controller in 5.2.4).
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Figure 67: The Bode plot shows an insufficient phase margin at about 200Hz which is caused by a too aggressive
setup of the integral. In time domain this causes oscillations of the position at 200Hz.
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Figure 68: The bode plot shows a sufficient phase margin with sufficient damping. This results in a nearly aperiodic
transient response in time domain.
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5.5.4 Acceleration and Velocity Feed forward.
The following setup is used to verify the acceleration feed forward (see also 5.4.10):

1. Prepare the scope by loading the Scope Configuration named Feed Forward Analysis.

2. Prepare the Axis Module: Setup a reasonable move between A and B. Activate the Loop After
check-box and set a wait time of about 500ms.

3. Start the scope and execute moves by pressing Move AB.

If the acceleration feed forward is correctly configured, the FeedForwardCurrent should match the ac-
celeration related part of ActualCurrentQ and the position error becomes much smaller compared to
without acceleration feed forward. In some cases also velocity feed forward has to be added to get a

good match.
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Figure 69: Feed forward signal with only acceleration feed forward (left) and with additional velocity feed forward
(right).
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6 Advanced Topics

This chapter handles topics which are not part of the basic setup of an axis described in chapter 5.

6.1 Commutation with Absolute Encoders

For the commutation of a synchronous AC motor the angle between the magnetic field of the rotor and
the stator windings needs to be known. With relative encoders, this angle has to be determined at least
after each restart of the drive which is called Phasing (see also section 5.2.7). With absolute encoders,
the commutation angle does not change relative to the encoder position and therefore the phasing has
to be executed only once. The resulting commutation angle can then be stored and reused after each
restart. The following absolute encoder protocols are supported:

= Endat

= BijssB, BissC

= Tamagawa

= Nikon
This section describes how to setup the commutation with absolute encoders and how the commuta-
tion angle can be saved to the drive or to the encoder.

Note Consider that mechanical adjustments of the encoder or the motor or replacement of the
encoder, motor or the drive affect the commutation angle and may require an execution of a
phasing-sequence to restore the commutation angle.

6.1.1 EnablingMethod

The parameter Commutation.EnablingMethod allows to define how the commutation angle is derived
from the absolute encoder. The following options are available:

+ AbsoluteEncoder: In this case the commutation angle is directly derived from the absolute posi-
tion of the encoder. This case requires a preset of the encoder by the manufacturer of the motor
or by the user (see section 6.1.2).

¢ AbsoluteEncoderOffsetEncoder: In this case the commutation offset is loaded from the encoder
memory. This requires a successful initial phasing of the axis followed by storing the offset to the
encoder (see section 6.1.3).

+ AbsoluteEncoderOffsetDrive: In this case the commutation offset is loaded from the drive mem-
ory. This requires a successful initial phasing of the axis followed by storing the configuration
persistent on the drive (see section 6.1.4).
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6.1.2 Set Absolute Encoder Zero equal to Commutation Zero
The following steps are required to set the encoder zero equal to the commutation zero:

1. The commutation sequence has to be set to RotorAlignment in Axes[].Parameters.Commutation
(see also section 5.2.7).

2. Execute the phasing-sequence by executing the command Axes[].Commands.Commutation.Com-
mand = StartPhasingAndZeroEncoder.

3. Check if Axes[].Signals.Commutation.State is Valid. If State is not Valid, check the configuration, es-
pecially the commutation settings, and restart the phasing-sequence.

4. To activate commutation based on the absolute encoder set Axes[].Parameters.Commutation.En-
ablingMethod to AbsoluteEncoder.

6.1.3 Save Commutation Offset to the Encoder
The following steps are required to save the commutation offset to the encoder:

1. The commutation sequence has to be configured correctly in Axes[].Parameters.Commutation
(see also section 5.2.7).

2. Execute the phasing-sequence by executing the command Axes[].Commands.Commutation.Com-
mand = StartPhasingAndSaveEncoder.

3. Check if Axes[].Signals.Commutation.State is Valid. If State is not Valid, check the configuration, es-
pecially the commutation settings, and restart the phasing-sequence.

4. To use the commutation offset from the encoder set Axes[].Parameters.Commutation.Enabling-
Method to AbsoluteEncoderOffsetEncoder.

6.1.4 Save Commutation Offset to the Drive
The following steps are required to save the commutation offset to the drive:

1. The commutation sequence has to be configured correctly in Axes[].Parameters.Commutation
(see also section 5.2.7).

2. Execute the phasing-sequence either
* by enabling the axis with the axis module (see 4.1) or
* by executing the command Axes[].Commands.Commutation.Command = StartPhasing.

3. Check if Axes[].Signals.Commutation.State is Valid. If not Valid, check the commutation settings
and restart the phasing-sequence.

4. To use the commutation offset from the drive set register Axes[].Parameters.Commutation.En-
ablingMethod to AbsoluteEncoderOffsetDrive.

5. If Axes[].Signals.Commutation.State is Valid save the configuration persistent on the drive (see sec-
tion 3.5.1) to store the commutation offset.

6.1.5 How the Commutation Offset is Derived

During startup of an encoder, the axis checks if the parameter axes[].Parameters.Commutation.En-
ablingMethod requires taking the commutation offset from any absolute encoder:

= AbsoluteEncoderOffsetDrive: try getting the offset from the persisted drive data.
= AbsoluteEncoderOffsetEncoder: try getting the offset from the encoder name plate.
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If this is successful, the commutation state will be Valid and enabling will be performed without phas-
ing.

If this fails, the axis will issue the error NoDigitalEncoderPersistency, which can be acknowledged. The
next enabling will then depend on the parameter axes[].Parameters.Commutation.PhasingMethod. If

this is NoPhasing, enabling will throw an error. Otherwise, the specified phasing method is executed
and enabling is possible.

With this concept, the user can specify, how the drive should behave in case of a missing absolute com-
mutation information.

6.1.6 Signals and States

Beside the parameters used to configure phasing different commands and signals are provided to ana-
lyze and debug the phasing sequence.

Axes[].Commands.Commutation.Command: This register can be used to control the phasing state and to
save the commutation angle to the encoder (if supported by the encoder™).

® |nvalidate: Sets the commutation state to Invalid which forces a phasing sequence (if specified)
when the axis is enabled next time.

= StartPhasing: Starts a phasing sequence as specified by the commutation parameters. StartPhasing
can be executed whether the axis is enabled or disabled. After a successful phasing, the commuta-
tion offset is written to the register Axes[].Signals.Commutation.OffsetAngle, the commutation state
is set Valid and the axis state will return to the state before the phasing.

= StartPhasingAndSaveEncoder: Same as StartPhasing but additionally the commutation offset is
saved persistent to the encoder. If EnablingMethod is set to AbsoluteEncoderOffsetEncoder this off-
set will be used for the commutation after a power cycle of the drive.

= StartPhasingAndZeroEncoder: Same as StartPhasing but additionally the zero of the absolute en-
coder is set equal to the zero of the commutation angle. This will cause a shift of the position. In
case the zero of the encoder is equal to the zero of the commutation angle it is possible to set the
parameter Commutation.EnablingMethod to AbsolutEncoder.

® |nvalidateEncoder: This command marks the commutation offset saved on the encoder as invalid.
After a power cycle of the drive, the commutation state will be Invalid.

Axes[].Signals.Commutation.State: This register displays the current phasing state.

= Disabled: The motor type and angle search method chosen do not require angle search (e.g. DC-
motor).

= |nvalid: A valid commutation angle is not yet set. This will force a phasing when the axis is enabled
next time.

= Phasing: The phasing sequence is ongoing.
= Hold: The phasing is frozen to allow saving of the commutation offset to the encoder.

= Valid: Any phasing was successful or the commutation offset was successfully derived from an abso-
lute encoder depending on the EnablingMethod parameter. In both cases the commutation offset is
written to the register Axes[].Signals.Commutation.OffsetAngle.

Axes[].Signals.Commutation.Angle: The commutation angle describes the magnetic field of the rotor rel-
ative to the stator-coils (Figure 70). The commutation angle runs from -pm to pm, where p is the number

10 Endat; BissB; BissC; Tamagawa; Nikon
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of pole pairs.

Figure 70: Commutation angle P ca
for a rotor with one pole pair.

Axes[].Signals.Commutation.OffsetAngle: The commutation offset is the angle between the encoder po-
sition and the zero of the commutation angle. This is the value evaluated during the phasing sequence.
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7 Flow Charts
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